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Thank you for purchasing Spark Creative Drum Machine! 
 

This manual concerns two distinctive products:  

• Spark software, a highly creative beat production center 

• Spark MIDI controller.  

 

Spark Creative Drum Machine user’s manual also covers Spark Vintage Drum Machine 
product.  However, some features are not available for Spark Vintage Drum Machine and 
are tagged with this icon: 

 

 

In this package you will find: 

• A DVD-ROM containing Spark Creative drum machine installer for Mac OS X 
and Windows XP/Vista/Seven 

• A registration card (credit card format) including the Serial Number and 
Unlock Code. 

• The User’s Manual for Spark Creative Drum Machine software and the Spark 
MIDI Controller. 

• Spark MIDI controller 

• An USB cable  

 

Carefully store your registration card! 

In order to actually use the software, you have to register, then authorize your virtual 
instrument. By registering, you identify yourself as the legitimate owner and thus will be 
sure to receive the latest news and updates for your instrument.  

The Serial Number and Unlock Code are required to register & authorize Spark, so these 
codes are the real value of your product.  

See chapter 3 Registration & Authorization for more information about the authorization 
process. 
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Special Message Section 
 

The MIDI controller uses USB or an external power adapter. Do not connect this product 
with any other power supply or adapter than the one described in this manual 
specifically recommended by Arturia. (See chapter 7.1.9  for more details). 

 

WARNING: 

Do not place this product in a place or position where one might walk on, trip over or roll 
anything over power or connecting cords.  

The use of an extension cord is not recommended! If you must use one, make sure the 
cord has the ability to handle maximum current needed by this product. Please consult a 
local electrician for more information on your power requirements. 

This product should be used only with the components supplied or recommended by 
Arturia. When used with any other components, please observe all safety markings and 
instructions that accompany the accessory products. 

 

SPECIFICATIONS SUBJECT TO CHANGE: 

The information contained in this manual is believed to be correct at the time of printing. 
However, Arturia reserves the right to change or modify any of the specifications without 
notice or obligation to update existing units. 

 

IMPORTANT: 

Always follow the basic precautions listed below to avoid the possibility of serious injury 
or even death from electrical shock, damages, fire or other risks. 

The product used either alone or in combination with an amplifier, headphones or 
speakers, may be able to produce sound levels that could cause permanent hearing loss. 
DO NOT operate for long periods of time at a high level or at a level that is 
uncomfortable.  

If you encounter any hearing loss or ringing in the ears, you should consult an 
audiologist. 

 

NOTICE: 

Service charges incurred due to a lack of knowledge relating to how a function or feature 
works (when the unit is operating as designed) are not covered by the manufacturer’s 
warranty, and are therefore the owner's responsibility. Please study this manual carefully 
and consult your dealer before requesting service.  
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PRECAUTIONS INCLUDE, BUT ARE NOT LIMITED TO, THE FOLLOWING: 

• Read and understand all the instructions. 

• Always follow the instructions on the instrument. 

• Before cleaning the instrument, always remove the electrical plug from the 
outlet, as well as the USB cable. When cleaning, use a soft and dry cloth. Do 
not use gasoline, alcohol, acetone, turpentine or any other organic solutions; 
do not use a liquid cleaner, spray or cloth that's too wet. 

• Do not use the instrument near water or moisture, such as a bathtub, sink, 
swimming pool or similar place. 

• Do not place the instrument in an unstable position where it might 
accidentally fall over. 

• Do not place heavy objects on the instrument. Do not block openings or 
vents of the instrument; these locations are used for air circulation to prevent 
the instrument from overheating. Do not place the instrument near a heat 
vent or any place of poor air circulation. 

• Only use the recommended specified AC adaptor (9 Vdc, 800 mA)  

• Make sure the line voltage in your location matches the input voltage 
specified on the AC power adaptor. 

• Do not open and insert anything into the instrument that may cause a fire or 
electrical shock.  

• Do not spill any kind of liquid onto the instrument. 

• Always take the instrument to a qualified service center. You will invalidate 
your warranty if you open and remove the cover, and improper assembly 
may cause electrical shock or other malfunctions. 

• Do not use the instrument with thunder and lightning present; otherwise it 
may cause long distance electrical shock. 

• Do not expose the instrument to hot sunlight. 

• Do not use the instrument when there is a gas leak nearby. 

• Arturia is not responsible for any damage or data loss caused by improper 
operations to the instrument. 

 

HANDLING CD-ROMS: 

Avoid touching or scratching the shiny underside (encoded surface) of the disc. A 
damaged or dirty CD-ROM disc may not read properly. Keep your CD-ROMs clean, using 
a commercially available CD cleaner. 
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1  INTRODUCTION 

1.1  WELCOME TO SPARK 

BEAT THE FUTURE 

Combining the power of analog synthesis, physical modeling and samples, through the 
intuitive workflow of a hardware drum machine, Spark is a highly creative beat 
production center. Spark will save you time when looking for the right drum kit and will 
get you hooked by its amazing ease-of-use and sound possibilities. 

Spark embeds vintage analog drum machines, sample based beatboxes and acoustic 
drum sets. Then Spark lets you break through their sonic boundaries thanks to a highly 
tweakable controller. 

With in-depth control over your sounds, an advanced loop mode and an XY touchpad 
with 8 real time effects, Spark will allow you to create unique beat experiments and 
constantly feed your creativity with innovative ideas. 

Spark’s sonic power is nothing but huge, embedding three distinctive drum engines: 
analog synthesis, sampling and physical modelling. Thanks to its automations available 
on all parameters, every kit is very tunable and customizable, bringing a fun and 
complementary approach to sample browsing while making it more interactive and user-
friendly than similar products. 

Incorporating a 16-step sequencer and 8 velocity sensitive touch pads into a sturdy beat 
station, Spark is your weapon of choice to bring the best groove into your tracks 
whether you are working in the studio or performing on stage. 

 

1.2. HISTORY 

In early 2001, Arturia began working on advanced algorithms for the digital emulation of 
analog circuit audio characteristics. They are known as TAE®, standing for True Analog 
Emulation. In non-technical language, this is an unprecedented way of creating the very 
unique sound one finds in a synthesizer such as the Moog Modular. Nearly a year after 
they began work on the algorithms, Arturia was ready for feedback. At the 2002 NAMM 
show in California, Arturia shared an early version of what would later be the Moog 
Modular V with the renowned maker of the original Moog synthesizer, Doctor Bob Moog. 

In seeking insight from sound production experts, such as Dr. Moog, as well as avid 
synthesizer users, Arturia was able to ensure the quality of the instruments they made; 
so well in fact the Dr. Moog himself endorsed the Moog Modular V. The launch of this 
sound powerhouse was an instant success, winning awards from several top magazines, 
and leading to the development of other synth recreations.  

Shortly thereafter, Arturia started receiving many requests from musicians, producers 
and bands. Many of them explained how they were planning to replace their original 
hardware synthesizers by virtual instruments. Artists around the globe were beginning to 
see the advantages of a software alternative to hardware-based synthesizers.  

The CS-80V emulated the legendary Yamaha CS-80, considered by many as "the 
ultimate polyphonic" synthesizer, and was launched at the AES 2003 in New York. 
Imagine some of your favorite music from diverse artists such as Keith Emerson or 
Stevie Wonder, and you'll get an idea of what the CS-80V is capable of. 
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The ARP 2600 V was launched at the NAMM 2005 in Anaheim. This is a faithful 
reproduction of the ARP 2600 and is great for just about any sound one might wish to 
create: everything from drum n’ bass stabs to Star Wars’ R2-D2 sounds have been made 
with the ARP. 

At the Winter NAMM Show 2006, ARTURIA announced the release of its seventh product: 
the Prophet V. This powerful hybrid gives you two instruments in one: it combines the 
warmth of the legendary Prophet 5 programmable analog synth with the unique Vector 
Synthesis textures of the digital Prophet VS. 

And finally, at the summer 2007 NAMM Show, Arturia launched the Jupiter-8V. In terms 
of sonic possibilities, it complemented its “Arturian siblings” by bringing something 
different. The Jupiter-8 V was capable of creating very versatile sounds. You could easily 
make 'fat' or ‘Crystal’ sounds with it. In fact, the Jupiter-8 sounded the way it looked, 
‘sleek and polished’. 

The electro-pop community became quickly convinced by the qualities of the original 
Jupiter-8. 'Relax', by Frankie Goes to Hollywood was produced incorporating a Jupiter 8, 
and players such Vince Clarke, John Foxx, and Martyn Ware also used it abundantly. The 
path to classic status of the Jupiter started there. 

Other artists that have used The Jupiter-8 include: Howard Jones, Tangerine Dream, 
Underworld, Jean Michel Jarre, Depeche Mode, Prince, Gary Wright, Adrian Lee, Heaven 
17, Kitaro, Elvis Costello, Tears for Fears, Huey Lewis and the News, Journey, Moog 
Cookbook, Yes, Devo, Freddy Fresh, Simple Minds, Jan Hammer and BT. 
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2  INSTALLATION 

2.1  WINDOWS INSTALLATION (7/XP/VISTA) 

• Place the installation DVD in your computer's DVD-ROM drive. 

• Use Windows® Explorer to browse the content of the DVD-ROM. 

• Double-click the installer file named SPARK Setup.exe. 

• Click Next. 

• To continue, you need to first accept the license agreement. After you have 
read the license agreement, check the corresponding checkbox and click 
Next. 

• To perform a complete installation, leave the Complete option checked and 
click Next. To deselect components or to install the SPARK application and 
sound library to an alternative location, select Custom. Then click Next. In 
the next dialog, choose the destination folders for the installation. To use the 
default path, just click Next. If you wish to select a custom path for a SPARK 
component, click Change, browse to the folder where you want to install the 
application or sound library. Then click Next. If you select VST (and/or VST 
64 bits) you will have to select your VST (and/or VST 64 bits) folder. 

• The Setup Program will lead you through the installation procedure. Follow 
the onscreen instructions. 

• After the installation has been performed successfully, click Finish. 

• Next, in order to install the SPARK Controller hardware driver, you need 
to connect the SPARK Controller to your computer. On Windows® Vista, the 
driver setup will finish automatically. On Windows® XP, installation is a two 
step process, described below. The following screen should appear:  

• Installation starts with Composite Device install: 
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• Choose “Yes this time only”, and click next. 

 

• Click next.  

• After processing, Composite Device will be installed correctly. 

• Installation should continue with USB Audio Device install. 

 

• Choose “No, not this time”, and click next. 
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• Choose “Install from a list or specific location”, and click next 

 

• Choose “Don’t search, I will choose the driver to install”. 

• Click Next. 
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• Click “Have Disk” 

• Click Browse, and locate Spark_XP.inf on Spark install DVD : 

[YourDVDdrive]:\Driver\Spark_XP.inf 

 

• Choose “Spark Controller”, and click Next 
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• Click “Continue Anyway”. 

Your Spark Controller should now be ready to use. 

2.2  MAC OSX INSTALLATION (10.5/10.6) 

• Place the installation DVD-ROM in your computer’s DVD-ROM drive. Its icon 
will appear in the Mac OS® X Finder. 

• Connect the SPARK Controller using the USB cable. If you want to 
connect the Controller to a USB-hub instead, make sure the hub has its own 
power supply. SPARK's Controller will not work on a passive (bus-powered) 
USB hub. 

• Double-click the SPARK DVD icon to display the content of the DVD. 

• Double-click the installer file named SPARK. 

• Click Continue to proceed. 

• To continue, you need to first accept the license agreement. After you have 
read the license agreement, press Continue and click Agree. 

• Select the hard disk onto which you would like to install SPARK. Please note 
that you can only install SPARK onto hard disks which contain a Mac OS® X 
version matching the system requirements. Hard disks with an incompatible 
Mac OS® X version will be flagged with a red Stop sign and you will not be 
able to select them from the Installation Destination dialog. From Mac OS® X 
10.5 on, this screen will be skipped automatically. 

• Click Continue. 

• Select the elements you want to install (we recommend installing all 
elements, however if you know that you don’t need a certain element like a 
plug-in format, uncheck the checkbox next to it). 

• If you want to install the SPARK Library contents to a custom location, e.g. to 
an external hard disk, click the folder icon in the Location column to open a 
dialog in which you can specify a destination for the installation. 
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• Click Install to continue. The Setup Program will lead you through the 
installation procedure. Follow the onscreen instructions. 
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3  REGISTRATION & AUTHORIZATION 

3.1  REGISTRATION 

Now that your SPARK Software has been installed, the first step is to register your 
software in order to obtain the activation code that will enable you to actually use the 
software. 

You should have handy the license serial number of SPARK Software and the unlock code 
(these are an integral part of the software and are printed on a small plastic card). 

Connect your computer to the Internet, and go to this web page: 

http://www.arturia.com/login 

If you don’t have an Arturia account yet, please create one now. This will take you to 
this form: 

 

If you already have an account, simply log in: 
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Once you are logged into your account, you can register your Spark and request your 
activation code. 

Go to the “My Registered Products” section of your account and click on the “Add” 
button: 

 

In the form that appears, select “SPARK Software” from the drop down menu, and key in 
your software serial number and unlock code (as written on the registration card), and 
click Submit: 

 

You should then see the confirmation screen, click Submit: 
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3.2  AUTHORIZATION 

 Please refer to the registration chapter in the Spark Vintage Drum 
Quick Start Guide. 

 

Finally there is a screen to copy the activation code. The very same information is sent 
to you by email as a backup. 

Copy the activation code and paste it in the window that shows when you launch 
SPARK: 

 

If your activation code has been entered correctly, the software will launch. 
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4  QUICK START 

4.1  SPARK CONTROLLER OVERVIEW  

 

 

1. Digital Display 

2. Sequencer zone 

3. Song/Pattern zone 

4. Jog dial 

5. FX live Pad 

6. Instruments control zone 

Connect the SPARK Controller using the USB cable. If you want to connect the Controller 
to a USB-hub instead, make sure the hub has its own power supply. SPARK's Controller 
will not work on a passive (bus-powered) USB hub. 
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4.2  SPARK SOFTWARE OVERVIEW 

This chapter will introduce you to the SPARK software’s user interface elements. If you 
need to look up a certain user interface element’s name, you can return to this chapter 
at any time for a refresher! 

Spark's user interface is divided in three main panels called: "TOP", "CENTER" and 
"BOTTOM". 

4.2.1 The Center panel 

When launching SPARK, the CENTER PANEL will appear by default.  

 

1. Digital Display 

2. Sequencer zone 

3. Song/Pattern zone 

4. Jog dial 

5. FX live Pad 

6. Instruments control zone 
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4.2.2 The Bottom panel 

The Bottom panel features the Studio, the Mixer and the Library. 

 

1. Studio Button 

2. Display Instruments 1 to 8 

3. Display Instruments 9 to 16 

4. Display all Instruments 

5. Mixer button 

6. Library button 

4.2.3 The Top panel 

The Top panel features the Pattern, the Song and the Preferences interfaces. 
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1. Pattern button 

2. Song button 

3. Preferences 

4.3  NAMES AND CONCEPTS YOU SHOULD KNOW 

This chapter will introduce you to SPARK's terminology and explain how these different 
elements relate to one another. 

4.3.1 Project 

A Project contains all data needed for a Song: a 16 instrument kit and up to 64 Patterns 
with their settings, automations and FX. 

4.3.2 Kit 

Each kit is made up of 16 instruments, i.e. Bass drum, Hi-hat, etc. 

You will find all of the instrument Kits in the Library, under the project window (Bottom 
panel).  

4.3.3 Instrument 

An instrument is a sound generated from an audio source assigned to a track pad. For 
example, you can assign the instrument Bass Drum to track 1, which you will then hear 
when hitting the bottom left pad in the main panel. 
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4.3.4 Audio Source 

Sample (.wav, .aiff audio files) 

Physical (Physical parameters) 

Analog (Vintage drum machines with analog parameters) 

4.3.5 Bank 

SPARK features 4 banks of 16 MIDI patterns each, called A-B-C-D.  

Go to the main panel, click on "A" and then "1" in the Song/Pattern zone. Then click on 
the play/pause button: you will hear the pattern number 1 of Bank A. 

4.3.6 Pattern 

A Pattern is a sequence of notes played by instruments.  

4.3.7 Song 

A Song is an editable ordered sequence of several patterns that defines your song 
structure.  

SPARK allows songs made of 64 patterns maximum. 

4.3.8 Channel  

A specific channel is assigned to each instrument in the Mixer. 

The channels are numbered from 1 to 16 in the same way the instruments are.  

4.3.9 Track 

The pattern window in the Top Panel shows you the 16 instrument tracks. Each track is 
the score played by one instrument.  

4.4  AUDIO AND MIDI SETUP 

4.4.1 Windows 

To access the preferences window, click on the SPARK menu > Setup > Audio & MIDI 
Settings. This window allows you to configure the global preferences of SPARK. These 
are saved automatically.  

4.4.2 Mac OS X 

To access the preferences window click on the SPARK menu>Preferences. The Audio 
settings window will appear. This  window features the global preferences of SPARK. 
These are saved automatically.  

For further details on how to setup Audio and MIDI, please refer to Chapter6 : MODES 
OF OPERATIONS of this manual. 
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4.5  FIRST STEPS WITH SPARK1 

4.5.1 Loading a project 

To load a project, go to the tool bar and click on LOAD.  

 

Move your cursor over "Factory Project" and click on a project in the drop-down list, for 
example "FUNK".  

This project is now loaded into SPARK and its name appears in the window next to the 
button "SAVE". 

4.5.2 Select and play a pattern 

To select and play a pattern, move your cursor to the "Song/Pattern" zone and choose a 
Bank of patterns, for example the BANK A (click on "A") and a pattern in BANK A, for 
example pattern #1 (Click on "1"). You will notice that your selection is now highlighted.  

 

Now, go to the transport zone and click on the "Play/Pause" button to listen to Pattern 
#1 in Bank A. To listen to a different pattern, just click on another pattern number. You 
do not necessarily need to stop playing a pattern to listen to another. The same applies 
to switching from Bank to Bank. 

                                       
1 When reading "Click" for the software version of SPARK, replace by "Press" for the Hardware version or refer 
to chapter 7 of this manual: THE SPARK MIDI CONTROLLER. 
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4.5.3 Change Instrument parameters 

The three knobs above each of the instrument's pad are the instrument's parameters. 
Let's try and change the pitch of the snare drum. While the pattern is playing, place your 
cursor over the "Pitch" knob, click on it and while maintaining your click and move your 
cursor up and down slowly. This will turn the "Pitch" knob up and down. Listen how the 
pitch of the Snare drum is changing. The Digital display window in the center of the main 
panel shows the changes applied to the Pitch (number of semitones).  

 

4.5.4 Select an Instrument and change filter and mixer parameters 

To select an instrument, for example the snare drum, move your cursor to the dividing 
line above the 2nd pad from the left called "Snare Drum". The dividing line is to the right 
of the instrument and will be highlighted to let you know that you have entered its 
selection zone.  

Click once. The "Snare drum" pad is now lit as well as the red LED. The instrument 
"Snare Drum" is now selected. Alternatively, hold the Select Button and press an 
instrument pad to select it. 

 

 

To change the filter and/or the mixer parameters, first select an instrument and simply 
click on one of the filter or mixer parameter buttons. While holding your click, move your 
mouse up or down to change the parameter's value. The Digital display window in the 
center of the main panel shows you the changes applied to the selected parameter in 
real time.  
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4.5.5 Play and edit a pattern 

To play a pattern use the Play/Pause button located in the upper left corner of the 
CENTER PANEL interface. 

 

To edit a pattern, you will use the 16 small pads located at the top of the main panel. 
You will notice that when you play a pattern, the current playing position is shown with a 
lit pad in real time. When a pad lights up, it means that the sequencer will play a MIDI 
note-on (a beat) at this pattern's position. If a pad is not lit, it means that no note will 
be played, therefore no sound will be heard. You can trigger a note-on or remove it by 
pressing these pads.  

To better understand, click on Bank A / pattern #1 and then select the snare drum 
track: 

Look at the 16 small pads at the top of the main panel: some pads are lit and others are 
not. The ones lit are the note-ons, those unlit are not triggering note-on messages.  

 

Every lit pad is a Snare drum's beat. You can edit this track by pressing a pad to add or 
remove a note-on. Try it! While the pattern plays, click on pads 2, 3, 4 and 5. They 
are now unlit, therefore you do not hear any snare drum beats any more. Now click on 
pads 1 and 4: you are starting to compose your own pattern. 

4.5.6 Record a pattern with instrument pads 

To do so, we will start by erasing the current pattern and start from scratch.  

First, click on the "ERASE" BUTTON, right above the digital display window and then go 
to the Song/Pattern zone and click on the currently selected pattern – it should be 
Pattern #1 of BANK A: 

 

The pattern #1 of Bank A is now erased. The 16 editing pads are not lit anymore (since 
the snare drum track is now empty as well as all the other instrument tracks). Click on 
Pattern #1. We are now ready to record a new pattern #1 with the instruments pads. 
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To use the Metronome, click on the Metronome Button, set its volume and proceed with 
recording your pattern. Clicking on the Metronome button again will switch the 
metronome off.  

Click on the pad called Bass Drum at the bottom left side of the Center panel. You are 
now playing bass drum. To record a Bass drum, click first on the record button and then 
on the play button, the recording has now started. 

 

Play your Bass drum part on the Bass Drum pad and then click stop. By clicking "Play", 
you will now listen to the track you just recorded. To record another instrument, select 
another instrument track (If you forgot how to do this, go back to 4.5.4 Select an 
instrument) and repeat the same steps to start recording.  

4.5.7 Change Instruments/Kits with the jog  

To change an instrument with the Jog Dial, you need to first select the instrument you 
want to change. Now, go to the Song/Pattern zone. Click above the Jog Dial where it 
says: "Instrument". Click on the Jog Dial and while holding your click, move your mouse 
up or down to select a new instrument. The name of the instrument will be displayed in 
the Digital display window in the center of the main panel. Once your choice is made, 
click on the Jog Dial to load the new instrument.  

 

The procedure to change a Kit is the same, except that you do not need to select an 
instrument since you're loading all of them. Just click below the Jog Dial where it says: 
"Kit", and follow the same procedure as with the instrument selection. 

 

Jog dial used in instrument mode includes a menu for selecting the instrument type and 
the generator type.  (See 5.2.4 Jog Dial section). 

4.5.8 Save your project 

To save your project, go to the toolbar and click "Save". A drop down menu will appear. 
Choose “Save as…” 
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Give a name to your project and choose a style from the drop down menu. Click "OK". 
Your first project is now saved. Congratulations! 

The name you gave to your project is now showing in the display window next to the 
button save. 

4.5.9 Switching views 

SPARK's interface is made up of 3 main panels. The "TOP" panel, the "CENTER" panel, 
and the "BOTTOM" panel. Up until now, you have only been introduced to the main or 
"CENTER" panel.  

You are now ready to discover everything SPARK has to offer. 

To show the "TOP" panel, go to the toolbar and click on "TOP". 

To show the "BOTTOM" panel, click on "BOTTOM" 

All 3 panels are now showing, you can scroll up and down to go from one panel to 
another. 
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5  USING SPARK 

5.1  THE TOOLBAR 

 

1. Load button 

2. Save button 

3. New Project window/Quick Load Menu (Most recently 
opened projects) 

4. Set Metronome volume button 

5. Set Metronome on 

6. Open or center "TOP" panel in the main window 

7. Open or center "CENTER" panel in the main window 

8. Open or center "BOTTOM" panel in the main window 

9. Connect Hardware 

10. CPU Meter 

11. Main volume meter 

12. Clipping indicator 

13. Set Soft clip on/off 
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5.2  THE MAIN PANEL (OVERVIEW)2 

 

1. Play instruments with Pads (Right click: Edit instrument) 

2. Instrument parameter knobs  

(Right click: edit motion/disable motion) 

3. Instrument Select Button (Hold select, then press an instrument pad.) 

4 Instruments page Button (Instrument 1-8 and 9-16) 

5. Mute Button (Click on mute, then on instrument(s).) 

6. Solo Button (Click on solo, then on instrument.) 

7. FX – Aux 1 and 2 – Pan and volume Knobs 

(Right click: edit motion/disable motion) 

8. Click zone to select instrument track 

 

                                       
2 When reading "Click" for the software version of SPARK, replace by "Press" for the Hardware version or refer 
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9. FX display window 

10. Filter Button (Right click: Always on/only on touch) 

11. Slicer Button (Right click: Always on/only on touch) 

12. Roller Button (Right click: Always on/only on touch) 

 

14. Jog Dial (Right click: Instrument mode/Kit mode) 

15. Bank select Buttons (A-B-C-D) 

16. Pattern select Buttons (1 to 16) 

17. Instrument select Button 

18. Kit select button 

19 Song select Button 
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20. Record button (Right click to select quantized/unquantized recording) 

21. Stop Button 

22. Play/Pause Button 

23. Tap Button (Tap tempo) 

24. Tempo knob (Change Tempo) 

25. Display previous/next 16 pattern steps 

26. Set accent mode Button (On patterns or steps) 

27. Erase/Cancel Erase Button  

(Use to erase Instruments or Patterns) 

28. Divide loop size knob 

29. Loop On/Off Button 

30. Move loop locator knob 

(Right click: Shift by one step/Shift by one loop size) 

 

31. Sequencer Steps: ON/OFF pads 

32. Shuffle knob  

(Right click: Swing range / velocity mode) 

33. Master volume knob 



ARTURIA – SPARK CREATIVE DRUM MACHINE – USER’S MANUAL 36 

5.2.1 The Digital display 

 

The digital display is of an invaluable help. It displays all the information needed while 
using SPARK. (i.e. Project name, precise changes applied when using Volume knob, FX 
knobs, etc.) 

5.2.2 The Sequencer zone 

 

The Sequencer zone is divided into several zones: 

5.2.2.1 The Step Pads 

 

16 Step pads numbered from 1 to 16. 

These pads allow you to edit your pattern by triggering note-on messages on your 
instrument track. Patterns have a maximum number of 64 steps. If your pattern has 
more than 16 steps, use the << or >> buttons to navigate to the previous or next page. 
If you click on the >> next page button, you will see the numbering on the pads switch 
from 1-16 to 17-32 for the second page, and so on. 

You may choose to follow the cursor as it advances on the step pads (the pages will 
change automatically) by right clicking on the >> button. A contextual menu will appear 
allowing you to check or uncheck the “follow current step” option. If this option is 
activated, both << and >> buttons will be lit. If the follow option is deactivated, the 
buttons will not be lit up. 

The step resolution is a sixteenth of a note by default. You can change the resolution in 
the pattern panel. (See Chapter 5.4.3) 

5.2.2.2 The Shuffle Knob 
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This knob sets the amount of shuffle applied to a pattern. Shuffle is a rhythmic shifting 
of a Pattern in which the first note in a series of two plays for a longer time than the one 
that follows.  

When the Shuffle knob is turned all the way up, the first note in a series will play twice 
as long as the one that follows. 

Right click on the shuffle button to set the swing range (1/4, 1/16, 1/32 of a note). This 
will define the value of the note on which the swing will be applied. 

Click on velocity mode to apply shuffle to the note velocity. 

Shuffle is a function better heard than described. Try it! 

5.2.2.3 The Transport Zone 

 

These buttons, from left to right, are: 

• Record 

• Stop  

• Play/Pause 

To record, click on the Record button and then on the Play/Pause button. The Record 
button will turn to red to indicate recording mode is on. 

To stop recording, click on the Stop button.  

To disable recording mode, click on the Record button again. 

While a pattern plays, clicking on the Play/Pause button will pause the playing. Click 
again on Play/Pause to resume playing. 

Click on Stop to reset current position to the beginning of the pattern. 

Right-click on the Record button to choose between quantized or unquantized recording 
function. 

 

In Quantize mode; the recorded notes will be set exactly to the nearest step position. 
When quantize mode is disabled, the recorded notes will keep the exact position they 
were played on. Spark uses the Shift parameter (see Chapter 5.4.5) to remember the 
exact triggering time relative to a step position. 

 

5.2.2.4 The Tap Button 

 

The Tap button allows you to define the tempo of your pattern by simply tapping this 
pad at the desired tempo. It is a beat/minute counter, so you have to tap the beats.  
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5.2.2.5 The Tempo knob 

 

The Tempo knob allows you to set the tempo for your pattern when SPARK is not 
externally synced to a host. The internal Tempo range is 10BPM to 300BPM.  

To temporarily push or pull tempo like a DJ might, hold the SELECT button and turn 
Tempo knob to temporarily increase or decrease the tempo, as you would push or pull a 
turntable, in order to synchronize Spark to an external audio source. 

5.2.2.6 The Accent Button 

 

The accent button allows you to set accents onto steps. Setting accents is very similar to 
writing a "forte" on a music score. The accented steps will be played with more strength 
that the unaccented ones. This allows for a very "natural" feel when listening to a 
pattern. 

Click on the accent button to set the sequencer steps to Edit accent mode. Now the 
sequencer's steps in the main panel show the accents set on steps (not to be confused 
with the note-ons in the normal Step mode). 

Set an accent by clicking on the step: the step will light up. Remove the accent by 
clicking on a highlighted step. 

To exit accent mode, click on the accent button again. 

Accent ON sets velocity to 127, Accent OFF sets velocity to 64. 

5.2.2.7 The Erase Button 

 

Click on the erase button to set Erase mode. 

You can erase Instruments, Banks or Patterns. 

For example, to erase pattern 1 in Bank A, make sure Bank A is selected then click on 
Erase and then on 1 in the Pattern section.  

5.2.2.8 The Loop zone 

 

Click on the button "ON" to set Loop mode on. 

The Divide knob allows you set the loop size. 

Moving the knob one notch will halve the loop size. 
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The settings are 1/2, 1/8 and 1/4 of the pattern size, all the way down to the minimum 
loop size: one step. 

The Move knob allows you to move the loop start in one of two ways. Using “Shift by one 
step” mode will shift the loop start to any given step of the pattern (stepwise). 
Alternatively, you can move the loop in increments of the loop size (defined with the 
divide knob) by using "shift by one loop size" mode. Right click on the Move knob to 
choose the Move Loop mode: “Shift by one step” or “Shift by one loop size”.  

 

5.2.3 The Song/Pattern zone 

 

The Song/Pattern zone is where you can trigger the Song mode, select and play your 
patterns, load Instruments or load a kit into your project.  

5.2.3.1 The Song Mode 

A Song is made up of a maximum of 64 patterns chained together. Click on the Song 
button to enter the Song mode. The Song button will flash continuously to let you know 
that you are now in Song mode. Click on the Play button in the transport zone. 

Listen! Your patterns are now chained together and played one after another from 
pattern to pattern and Bank to Bank.  

The Step pads (numbered from 1 to 16 at the top of the Center Panel) light up as each 
pattern is being played. They show you which pattern is currently being played.  

To edit your Song, refer to Chapter: 5.4.6 The song panel 

5.2.3.2 Editing Songs from the Main panel 

As we have just seen, a Song is made up of several patterns chained together. The order 
in which each pattern is played can be changed from the main panel.  

When in Song mode, each step pad, numbered from 1 to 64 represents the position 
occupied by a pattern in the chain (to select the next page, click on the next 16 steps 
page button >>). 
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When the Song plays, the step pads will light up successively showing you which pattern 
is currently being played in the chain.  

The number under the step pad represents the position of a given pattern in the chain. 
This number has no relation whatsoever with the pattern number. For example, you can 
decide that the pattern B-12 will be played first, then pattern A-1, and so forth. 

To edit a song, first of all make sure you've selected the Song mode by clicking on the 
Song Button. The song button should blink. 

Then, press the record button in the transport zone. You are now ready to assign a 
location to your patterns in the chain.  

Let's say you want pattern A-2 to be in first position when playing the song. Click on 
Step pad #1 and then, in the Song/pattern zone, click on Bank A then on pattern 2. 
That's it. When you will play your song, pattern A-2 will be the first pattern of your song. 

Repeat this operation to create your song. Remember to click on the next or previous 16 
pattern page button [>> or <<] to go to the next or previous page.  

5.2.3.3 Banks and Patterns 

The patterns are organized in 4 banks (labeled from A to D) of 16 patterns each 
(numbered from 1 to 16). 

To select pattern number 6 of Bank B, click on Bank B and then on pattern 6. The 
selected pattern can now be played when clicking on the Play button in the transport 
zone.  

But you can also use the Song/Pattern zone to copy or swap patterns in the currently 
selected Bank.  

To copy a pattern, drag and Drop a pattern number while holding [Option/Alt] on Mac 
OSX or [Ctrl] on Windows and drop it on another pattern number. A pop-up menu will 
ask you to confirm your choice. Click Ok.  

 

To swap patterns, simply drag and Drop a pattern number onto another one. A pop-up 
menu will ask you to confirm your choice. 

The exact same procedure applies to copying or swapping Banks.  

5.2.4 The Jog Dial 

 

The Jog Dial allows you to load Kits, Instruments or projects when working on an open 
project. You may choose (via the preferences tab in the upper screen) to assign the Jog 
dial to switch between either Instruments and Kits using the “Switch from Instrument to 
Kit Mode”, or else between Instruments and Projects using the “Switch from Instruments 
to Projects Mode”. By default Spark is set to “Switch from Instrument to Kit Mode”. 
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To load a kit (or Project, depending on preference settings), click on "Kit" under the Jog 
Dial. Click on the Jog dial and while maintaining your click, move your mouse up or down 
to select a kit.  

The kits name will appear in the center display window. Then, click on the Jog dial again 
to load a new kit. 

To load a new instrument to an instrument pad, first select the instrument pad you want 
the instrument to be assigned to. Then, click on “Instrument" above the Jog dial. Next, 
click on the Jog Dial and while holding move your mouse up or down to select a different 
instrument. The list of Instruments will appear in the center display window. Select an 
Instrument and then click on the Jog dial once again to confirm your selection. 

You may switch between Kit and Instrument modes by either clicking on their names, or 
else by right clicking on the Jog Dial. A contextual menu will appear and allow you to 
choose between the two Jog Dial modes. 

The new instrument is now assigned to the previously selected Instrument pad; the new 
instrument's name appears below the pad. 

The Jog dial, while used in instrument select mode, includes the ability to select the 
instrument type and the generator type. 

By default, the jog dial scrolls through a list of instruments without having to select the 
menu options. The default list is made of all available instruments with the same type of 
the selected instrument. 

By pressing and holding SELECT and then pressing the switch on the Jog Dial, you can 
select the Instrument type and Generator type. 

First menu level is for selecting the instrument type or ALL types: 

ALL, Bass drum, Snare Drum, Close Hit-Hat… 

 
Second level is for selecting the generator type or ALL types: 

ALL, Analog, Physical Model, or Sample 

 
The result list will then be displayed. If you choose Bass Drum > ALL, all bass drums will 
be displayed. If you choose Snare Drum > Analog, all analog snare drums will be 
displayed. 

Pressing the Jog Dial again will then take you to the list of instruments with the selection 
filters applied. 
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5.2.5 The FX Live Pad 

 

The FX live pad is an amazing performance tool, especially if you plan on playing live. Its 
touch sensitive screen will apply live effects in real time to your song or patterns, 
allowing you to shape your sound with great precision. When your cursor enters the FX 
pad zone, it turns from an arrow to a cross.  

The FX Pad features 3 main effect buttons called Filter, Slicer and Roller. By right clicking 
on any of them, you can choose between: "Latch" or "Touch". "Latch" will not cut off the 
effect when releasing your finger, the "Touch" option will cut off the effect upon 
releasing your finger: the effect is only active when the Pad is touched/clicked on. 

You can also enable LATCH mode from the hardware by pressing and holding SELECT 
and then pressing the Filter, Slicer or Roller buttons. 

 

In Latch mode you can combine the Filter and Slicer effects together: To slice the filtered 
sound, set the filter effect to latch mode. Now you can touch the pad and set your filter 
setting you want. Next press the Slicer button on. You will have the Filter set to your last 
setting and can play the slicer on the XY pad.  

Note that the Roller effect is not active when Slicer is set to latch mode. 

 

5.2.6 The Filter / Slicer / Roller 

5.2.6.1 The Filter Button 

The Filter button offers a Low pass, a Band pass and a High pass filter with cutoff and 
resonance.  

To select Low pass, Band pass or High pass, click on the FILTER button repeatedly. Your 
choice will be displayed on the center display window. 

The Cutoff and resonance can be modulated with the mouse on the software version or 
your finger on the hardware XY pad.  

The resonance is modulated vertically from the bottom of the pad to  the top of the 
pad.  

Cutoff is modulated horizontally, from the right side of the pad to the  left side of the 
pad.  

Play a pattern of your choice and click or touch anywhere on the right edge of the FX 
pad while maintaining your click or touch; draw a straight horizontal line towards the left 
side of the FX pad. You will hear the cutoff modulating. The amount of modulation 
applied can be seen on the center display panel. 

Now place the cursor close to the bottom right corner of the FX pad and trace a line 
straight up to the top edge of the pad. You are modulating the resonance.  
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Of course, both Cutoff and Resonance can be modulated simultaneously by moving your 
finger or the mouse in any direction and at any speed you wish. 

5.2.6.2 The Slicer button 

The Slicer will repeat the value of the note selected while applying an effect. You can 
choose between the following effects: 

 

Repeat mix 

Click to choose the value of the note to be repeated with the Repeat mix effect. The 
effect will be applied for the amount of time your mouse click is maintained. Release 
your click to cancel and resume normal playing. 

Repeat mix will continue playing the pattern while the effect is applied. 

Repeat 

The Repeat effect is the same as Repeat mix, except the pattern is not played while 
applying the effect. 

Tape 

The Tape effect simulates the effect of slowing down a tape player. 

Reverse 

The Reverse effect simulates the effect of playing a tape recording backwards. 

Strobe 

The Strobe effect will play and shut off the sound alternatively at the rate of the selected 
note value.  

Pan 

The Pan effect will move the sound from the left speaker to the right speaker at the rate 
of the selected note value. 

Bit Crush 

The Bit Crush effect allows you to reduce the audio bit rate, creating a Bit Reduction or 
Bit crushing sound effect. Reduce the audio anywhere from 7 down to 2 bits. 

5.2.6.3 The Roller button 

The roller could be described as a "Drum roll" tool. 



ARTURIA – SPARK CREATIVE DRUM MACHINE – USER’S MANUAL 44 

 

Choose the note value for the Roller effect. Then, click and maintain your click on the 
snare drum pad. The snare drum will play a basic drum roll. The roll speed depends on 
the selected note value. 

You can play, of course, any instrument pad using this effect. 

The beginning of the roll is quantized by default.  

A swing effect can be added by simply clicking on the upper note values for Swing on, or 
on the bottom values for Swing off. When swing is off, one beat is played per note value.  

When Swing is on, a beat is added before the second beat resulting in playing close to a 
triple time bar.  

The ROLLER can be LATCHED on by pressing and holding SELECT + ROLLER button. Now 
any pad you play will have the roll effect played. This is a great way to enter notes into a 
pattern. 

5.2.7 The Instrument control zone 

 

The instrument control zone is made up of: 

5.2.7.1 The instrument Pads  

There are 16 instrument Pads but only 8 of them are shown on SPARK's interface. To 
navigate to the next set of 8, click on the 1-8/9-16 button. 

An instrument is assigned to each pad. The far left pad is by default the Bass Drum, next 
to it is the Snare drum, and so on; but you can of course personalize this arrangement.  

To edit an instrument, right click on the pad, and then Click on edit. This will take you to 
the "STUDIO" bottom panel where you will be able to edit a full array of instrument 
parameters. (See next chapter 5.3.1 The Studio). 

5.2.7.2 The Parameter Knobs  

Each instrument pad has 3 parameter knobs above it.  
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These parameters act on the sound generator to modify the sounds in real time so as to 
give each sound its own color. Each instrument has 6 parameters (3 of which are 
mapped to the knobs).  

You may choose which parameter each knob modifies by clicking on the name 
underneath the knob. A contextual menu will appear listing the 6 parameters available in 
addition to the Filter, Mixer and available Fx parameters (if an effect is set as insert on 
the instrument’s mixer track). Click on a different parameter name to assign the knob to 
that parameter. To select different parameters via the hardware controller, Press and 
hold SELECT and turn the knob that you want to change assignment on. You will see the 
different parameters in the LCD screen and on the software screen. 

Common instrument parameters are tuning/pitch, filter cutoff envelop decay, attack and 
release, different effect depths and rate (ring, shift, etc).  

Filter parameters are Cutoff and Resonance. You can set the filter type for each 
instrument in the studio panel. 

Mixer parameters are Aux1 effect amount, Aux2 effect amount, Panning and Volume. 

Fx parameters depend on the chosen insert effect set on the instrument mixer track. 
Each effect has its own parameters exposed as well (dry/wet, feedback, delay time…) 

You do not need to select a specific instrument to change its parameter. Any effect is 
applied in real time while the pattern is playing.  

The parameter motion can be recorded as an automation into the pattern and edited 
later accurately using the automation graphic editor. (see chapter 5.4.5 ). 

You can also quickly delete an automation you created on the hardware by pressing 
ERASE then moving the knob of the parameter whose automation you want to delete. 

Right click on a parameter knob to edit the corresponding automation. You can also 
choose to momentarily disable a Motion parameter in this way. 

5.2.7.3 Select Button  

The Select button allows you to easily select an instrument. Just clickor press[Select] 
and then on the instrument pad of your choice to specifically select the corresponding 
instrument. 

This function was designed to quickly select an instrument when using the Spark 
controller. 

The Select button is also used to access many other secondary functions of buttons and 
knobs.  

 

5.2.7.4 1-8 / 9-16 Button  

The main panel interface shows 8 instrument pads while a kit contains 16 instruments. 

To navigate to the next set of 8 instruments, click on this button.  

5.2.7.5 Mute button  

This button allows you to bypass the audio sound of a specific instrument. Click on the 
Mute button and then choose the instrument you wish to mute. You will no longer hear 
that instrument when playing your pattern. When in mute mode, you can select multiple 
instruments to mute them together. 

5.2.7.6 Solo button  

The Solo button mutes the other instruments besides the one(s) selected. Click on the 
Solo button and then choose the instrument you wish to solo. You will only hear that 
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instrument when playing your pattern. When in solo mode, you can select multiple 
instruments in order to solo them together. 

5.2.7.7 Filter/Mixer parameters  

A specific filter is applied to each instrument of a kit. The filter type can be changed in 
the Studio Edit instrument view. (See next chapter 5.3.1 The Studio). 

To change the filter and/or the mixer parameters, first select an instrument and simply 
click on one of the filter or mixer parameter knobs and while maintaining your click, 
move your mouse up or down to change the parameter. The Digital display window in 
the center of the main panel shows you the changes applied to the selected parameter in 
real time. 

These motion parameters can be recorded as automations into the pattern and edited 
later accurately using the automation graphic editor. (See chapter 5.4.5 ). 

Right-click on a Filter or Mixer knob to edit or disable its Motion. 

• Cutoff: Set Filter cutoff on current instrument 

• Resonance: Set Filter resonance on current instrument. 

• Aux1/Aux2: Set Aux1 or Aux2 amount on current instrument. 

• Pan: Set amount of Pan on current Instrument 

• Volume: Set the volume on current Instrument 

 

5.3  THE BOTTOM PANEL (OVERVIEW) 

 

The Bottom panel features the Studio, the Mixer and the Library. 

To access the Bottom panel from the Main panel, go to the toolbar and click on 
"Bottom". 

Right click on the picture to change the background. A pop-up menu will let you choose 
between:  

No background 

Classic drums 
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Electronic drums 

Physical drums 

Electro box 

5.3.1 The Studio4 

 

The studio panel displays all your instruments as well as their parameters. 

From here you can load instruments into slots, apply filters and effects, etc. 

The picture above shows the 1-8 instrument view. 

Let’s look at the Bass drum window: 

 

                                       
4 Not available in the Hardware version of SPARK. 
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1. Load a new instrument 

To load a new instrument, click on the down arrow. A drop-down menu will 
appear listing all the instruments available in Spark. They are organized by 
type (16) from Bass Drum to Synth, and each type has 3 categories 
(Analog, Physical Model or Sample). Choose a new instrument in the list and 
click on its name. 

2. Instrument icon 

Clicking on this icon will trigger the instrument's sound. You may drag the 
icon to another instrument icon to make a swap operation or hold Ctrl and 
drag it to another instrument icon to make a copy.  

3. Set Pan 

Click and maintain click to set panning. 

A small window appears next to the knob to let you know the amount and 
direction of pan applied. Click right to edit or disable pan motion.  

4. Set volume  

Click and maintain click to set volume. 

A small window appears next to the knob to let you know the amount and 
direction of volume applied. Click right to edit or disable volume motion.  

5. Mute an instrument  

The Mute button on the center panel will flash to indicate that a Mute has 
been set from another panel (studio, mixer or sequencer). 

6. Set solo on an instrument 

The solo button on the center panel will flash to indicate that a solo has 
been set from another panel (studio, mixer or sequencer).  

7. Edit mode button 

Click on the Edit mode button to enter the instrument edit Mode.  
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5.3.1.1 Instrument Edit Window 

 

1 Change instrument type. You may also drag and drop 
an audio file here (and also directly onto an 
instrument pad).  

When dragging and dropping onto pads: if the current 
instrument is sample based it will replace the previous 
sample with the new one. If the current instrument is not 
sample based, a menu will appear asking if you’d like to 
change the instrument type. 

2 Rename instrument. 

3 Turn Mute on (M) / Turn solo on (S). 

4 Set pan. 

5 Set volume. 

6 Change filter type on instrument. 

7 Cutoff filter knob. 

8 Resonance filter knob. 

9   

Sample layer display for each layer - Numbered 1 to 
6 

(For Sample type instruments only)  

10  

Load new sample. 
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11  

Set reverse mode on sample. 

12  

Unload a sample. 

13  

Layer display window. Drag and drop audio file here 
to change the layer’s sample. 

14  

Layer tool. 

15  

Gain knob for sample. 

16 Change Center panel knob assignment. 

17 Change value for parameter 1 (out of 6 total) of 
edited instrument. 

18 Play edited instrument. 

19  

Link button: links layers together so that gain, 
reverse, start and end points are the same on all 
layers. To edit these parameters individually on each 
layer, Link should be off. 

5.3.1.2 Studio Buttons 

  

 

 

 

 

 

 

Click on the 1-8 button to display the first eight Instruments. 

If you want to see all of your instruments displayed at once, click on "All". 

 

1. Display Instruments 1 to 8 

2. Display Instruments 9 to 16 

3. Display all instruments / Hide Instrument view 
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5.3.2 The Mixer6 

Click on "Mixer" to display the Mixer panel 

 

This panel is your 16 channel mixer panel. This is where all your instruments will be 
mixed together. Here, the modified signals will be summed to produce the combined 
output signals. 

Each track is numbered from 1 to 16 at the top of the window. To the right of the mixer 
window are Return1 – Return 2 and finally the Master track. 

Let's take a close look at the Mixer. 

5.3.2.1 The Instrument tracks 

 

                                       
6 Not available in the Hardware version of SPARK. 
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1 Assign an output for instrument 1 (available when Spark 
is inserted into a host sequencer with Multi-output Mode. 
See chapter 6.2 Plug-in mode for more details). 

2 Set Aux1 amount for instrument/Channel 1 

3 Set Aux1 amount for instrument/Channel 1 

4 Set Pan for instrument/Channel 1 

5 Open FX1 window for instrument/Channel 1 

6 Open FX2 window for instrument/Channel 1 

7 Set Solo/Mute for instrument/Channel 1 

8 Change volume for instrument/Channel 1 

9 Instrument name  

To select a track click on the bottom of the track, on the instrument's name. 

5.3.2.2 The Return 1 and 2 tracks 

 

 

 

 

 

 

1 Open AUX FX window 

2 Set volume for AUX return 
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5.3.2.3 The Master track 

 

1 Open Master insert 1 FX window 

2 Open Master insert 2 FX window 

3 Set Master volume 

5.3.2.4 The Effects 

When you click on one of the Aux FX buttons, a scroll up window will appear: this is the 
AUX FX window. 

 

To select an effect, click on [SELECT EFFECT].  

Choose one from the list, for example Compressor. The compressor window appears. 

You can now set the parameters for the Compressor FX. 

FX parameters 
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1 Bypass all effects  

2 Close FX window 

3 Bypass FX1/FX2 for one instrument /channel-Aux-Master insert 

4 Change/Remove FX (Inst./Channel, Aux or Master insert) 

5 Load a factory FX preset 

6 Set Dry/Wet mix (Inst./Channel, Aux or Master insert) 

 

Compressor parameters 

  

1 Change Input gain 

2 Change Threshold 

3 Change Attack 

4 Change Ratio 

5 Change Release 

6 Change Makeup 

A compressor evens out differences in gain by reducing dynamics (difference in volume 
between quiet sounds and loud sounds). This effect is often used to ‘fatten’ a sound by 
making every individual element of the sound closer to the same volume. Every time a 
sound goes over a certain volume (Threshold), it is reduced by a specified amount 
(Ratio). Attack and Release determine how quickly the reduction is added and how 
quickly it disappears. Makeup boosts the compressed signal’s level. 
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Bit Crusher parameters 

 

1 Change Bit depth 

2 Change Downsample 

A bit crusher reduces the bit depth and sample rate of the audio signal. The result is a 
very digital sounding distortion. 

Chorus parameters 

 

1 Change Shape 

2 Set Tempo sync on/off 

3 Change Rate 

4 Change Depth 

5 Change Feedback 

6 Change Spread 

7 Change Delay 

Chorus is a classic effect that uses small delay times (that are modulated by an LFO) to 
double a sound, making it seem fatter and thicker. Shape, rate and depth refer to the 
LFO. Delay is the delay time and feedback is the amount of delayed signal added back to 
the dry signal. Both of these parameters emphasize the effect when increased. Spread 
refers to the width of the sound in the stereo field. 
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Delay parameters 

 

1 Delay output (Link/Unlink). 

Apply (Disable) same values for right and left 

2 Set time for left and/or right channel 

3 Set Feedback for left/right channel 

4 Set ping-pong mode on/off (Can be turned on only if "Link" is 
off.) 

5 Set Damping value 

 

6 Set tempo sync on/off 

A delay repeats a sound, giving it more space and depth. Linking channels applies the 
left channel’s delay time and feedback to the right channel. For separate parameters on 
both channels Link should be deactivated. Ping Pong alternates the delayed signal 
between the left and right channel (for an increased stereo effect), and dampening 
reduces high frequencies by adding a Lowpass filter to the feedback chain.  

Distortion parameters 

 

1 Change Distortion type 

2 Change Drive amount 

3 Change Output gain 
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A distortion saturates and distorts a sound by increasing the volume of a signal then 
clipping the excess. This effect can add strength, high-end and be volume to a sound. 

Parametric EQ parameters 

 

1 Change Low gain 

2 Change Low frequency 

3 Change Middle frequency 

4 Change Middle gain 

5 Change Middle band frequency width 

6 Change High frequency 

7 Change High gain 

Parametric EQ allows one to boost or reduce the volume of frequency bands. FREQ 
selects the frequency and GAIN allows one to remove or add volume to that band. Width 
(MID only) determines the width of the middle band around the specified FREQ. 

Phaser parameters 

 

1 Change Tempo sync on/off 

2 Change Rate on stage 1 and/or stage 2 
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3 Change Feedback on stage 1 and/or stage 2 

4 Change Depth on stage 1 and/or stage 2 

5 Change Shape on stage 1 and/or stage 2 

6 Set Dual mode on/off 

A phaser is similar to a chorus effect, in that it uses small delay times to affect a signal, 
the result is a sweeping comb-filter sound. 

Plate Reverb parameters 

 

1 Change Reverb size 

2 Change Pre-delay size 

3 Change Stereo value 

4 Change Reverb filter damping 

5 Change Low cut frequency filter 

6 Change High cut frequency filter 

A reverb emulates the reflections of a sound in a different space (room, hall, etc). 
Reverb adds depth and richness to a sound by ‘placing’ it in a separate physical space. 
The size knob changes the size of the space. Predelay adds a small amount of delay to 
the sound to imitate early reflections. Stereo refers to the width of the stereo field of the 
reverb. Dampening sets how much the reverb should be filtered using the Lo and Hi Cut 
filter settings.  
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Reverb parameters 

 

1 Change gain 

2 Change High frequency damping 

3 Change Brightness 

4 Change Diffusion 

5 Change Decay time 

6 Change Pre-delay Feedback 

7 Change Pre-delay Time 

A reverb emulates the reflections of a sound in a different space (room, hall, 
etc). The material section (HF Dampening and brightness) sets the timber for 
the reverb (dark or bright sounding). The shape section (Diffusion and Decay 
time) sets the size and duration of the reverb. The pre-delay section (Feedback 
and Delay) adds a small delay to the reverb to emulate early reflections. 

Destroyer parameters 
 

 

1 Clipping 

2 Harmonic Distortion 

3 Bit Reducer 
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4 Resampler 

5 Tone 

6 Gain 

 

A Destroyer is an digitalizer effect which produces a distortion by the reduction 
of the resolution or bandwidth of digital audio data. The resulting bit 
reduction may produce a “warmer” sound impression, or a harsh one, depending 
on the amount of bit reducter and resampler.  Harmonic distortion 
adds overtones that are whole number multiples of a sound wave's frequencies. 

 

Flanger parameters 
 

 

1 Delay Time 

2 Depth 

3 Rate 

4 Feedback 

 

Flanging effect by mixing two identical signals together, with one signal delayed 
by a small and gradually changing period. Varying the time delay causes these 
to sweep up and down the frequency spectrum. The delay time between signals 
is modulated: Flanging can create both subtle and extreme effects, depending 
on the rate and depth of the modulation. High values for Feedback will create 
repeated echoes. 
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Space Pan parameters 
 

 

1 Pan 

2 Motion 

 

Space panning is the spread of a sound signal into a new 3D sound field. The 
sound will be set at a position or automatically (Pan set to 0) and the position 
will be modulated with the motion parameter. Space pan must be used on stereo 
sounds. 

Sub Generator parameters 
 

 

1 Type 

2 Release 

3 Threshold 

4 Tune 

 

 

Sub Generator adds low frequency to your signal. Sub Oscillator adds a decaying 
boom. Subgrunge and Subgrunge -1 Oct have a similar effect to compress low 
frequencies. Subgrunge -1 Oct works at an octave below like an octave pedal 
guitar. Vintage Sub-Harm adds a smooth sub-octave using the release time 
parameter. Tune is the maximum boosted frequency, at low value it helps 
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reducing distortion. Threshold is used to gate the low frequency effect and stop 
unwanted background rumbling.  

Sub Generator parameters 
 

 

1 Threshold 

2 Knee 

3 Attack 

4 Release 

5 Gain 

 

A Limiter is a compressor with a high ratio and a fast attack time. A limiter 
reduces the level of an audio signal if its amplitude exceeds a certain threshold. 
Attack and Release determine how quickly the reduction is added and how 
quickly it disappears.  Hard of Soft Knee controls whether the bend in the 
response curve is a sharp angle or has a rounded edge. A soft knee reduces the 
audible change from uncompressed to compressed. 

 

5.3.3 The Library 

Click on "Library" to display the Library panel. 

The library is divided into 2 main windows: the library window and the current project 
window. 
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5.3.3.1 The Library Window 

 

1 Display Factory project only (Click to select) 

2 Display User project only (Click to select) 

3 Import a project to the Library 

4 Make a new project 

5 Delete a project from the Library 

(Only user projects can be deleted) 

6 Display Kit/Instruments information for one project in Library. Double click 
on kit to Load it. 

7 Load a Bank (A,B,C or D) from the Library to the corresponding one in the 
Current project 

8 Load a Pattern (1 to 16) from the Library to the corresponding pattern in 
the Current project 

9 Load a kit from the Library to the current project 

10 Load an instrument from the Library to the corresponding selected 
instrument in the Current project 

11 Enter "Edit current project" mode 

12 Select a project in the coverflow. 
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5.3.3.2 The Current Project window 

  

1 Import a MIDI file or a REX file in current pattern 

2 Export current project as .ads file (SPARK) or export current 
pattern as MIDI or AUDIO file 

3 Save current project 

4 Save current project to new project 

5 Exit current project edit mode (takes you back to the 
“Coverflow” dynamic Project menu). 

6 Change image for current project 

7 Change the style of the current project 

8 Change author name 

9 Bank list of the current project 

10 Pattern list of the current project 

11 Loaded instruments of the current project 

5.3.3.3 Creating a new project 

To create a new project, click on the "New Project" button in the library window.  

5.3.3.4 How to load Kits and Instruments 

To load a Factory or user project in your current project, double click on an instrument 
kit in the Library/Project window. This will load the entire kit to your current project.  

To load one or several instruments from a kit, go to the Library/Instruments window. 

Double click on an instrument to load it to your project. When double clicking on an 
instrument, it is placed in the selected instrument slot in the Loaded Instruments window 
in the current project window. To select a slot, click on the instrument number in the 
Loaded Instruments window. 

An easier way is to "Drag and Drop" an instrument from the “Instruments" window to 
any slot in the Loaded Instruments window. 
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You do not need to select an instrument slot when doing it this way. 

5.3.3.5 How to load Banks and Patterns 

In the same way, you can load a bank or a pattern from the library to the same bank or 
same pattern number in your current project by double clicking on it.  

If you want to load Bank A from the Library to Bank D of your current project, drag and 
drop Bank A on to Bank D. 

To load pattern A1 to pattern C3 of your current project, simply drag and drop A1 to C3. 
Pattern C3 will light up to confirm your selection. 

5.3.3.6 Importing and Exporting a project 

To import a project click on the "Import" button in the current project window. A menu 
lets you choose between MIDI file and REX file formats. 

To export a project click on the "Export" button in the current project window. A menu 
lets you choose between:  

• Exporting as a SPARK project (.spk) 

• Exporting selected pattern as a MIDI file (.mid) 

• Exporting selected pattern as an AUDIO file (.wav) 

It is also possible to export a bank or pattern as a MIDI or WAV file (option to be set in 
the Preferences Panel) by simply dragging and dropping. To do this click on the bank or 
pattern you wish to export. Hold your click and drag the element to the place of your 
choice on your computer (desktop or host sequencer for example). If you dragged a 
Pattern, a single MIDI or WAV file will appear. If you dragged a bank, 16 separate 
MIDI/WAV files (corresponding to the 16 patterns of the Bank) will be created. In case of 
an Audio export you need to hold your click until rendering is completed, otherwise your 
render will be cancelled. Alternatively you can right-click on the pattern and select 
render option. A *(star) will be added at the end of pattern name to show that the 
pattern has been rendered. Ex: A1*.  

You can personalize the cover image of your project: 

Click on "Change image" next to the current cover image. Choose a picture in your own 
picture library and click on “Open” to replace it.  

5.3.3.7 Saving a project 

To save your project, click on the "Save as" button. 

A drop down menu will appear. Chose "Save as…" in the current project window. Give a 
name to your project and choose a style from the drop down menu. Click "OK". Your 
project is now saved.  

If you make changes to a project you already saved just click on the button "Save". 

5.3.3.8 Changing kit name 

To change the name of your kit, double-click on the kit name in the upper left 
part of the current project window and rename it. Don’t forget to save your 
project. 
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5.4  THE TOP PANEL 

5.4.1 Overview 

The top panel features the Pattern panel and the Song panel as well as SPARK 
preferences menu.  

When you click on the "TOP" button in the toolbar the pattern window opens by default. 

At the bottom of the panel you will find the Pattern Panel button, the Song panel button 
as well as the Preferences button. 

 

5.4.2 The Pattern Panel 

 

 

The Pattern panel features SPARK's sequencer. It is both a composing tool as well as a 
powerful editing tool.  

 

5.4.3 The Toolbar 

  

 

1 Change upper part 

2 Change lower part 

3 Change step resolution 
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4 Change number of bars 

5 Change number of steps 

6 Click to display patterns 1 to 16 

The time signature is a notational convention used in musical notation to specify how 
many beats are in each measure and which note value constitutes one beat. 

Time signatures consist of two numerals, one stacked above the other: the lower 
numeral indicates the note value that represents one beat (the "beat unit"). 

The upper numeral indicates how many such beats there are in a bar. 

For instance, 4/4 means four quarter-note (quarter note) beats; 3/8 means three 
eighth-note (quaver) beats, etc. 

 

1. Click to change the upper part of the time signature of the current pattern. This 
defines the number of notes (units) in one bar: Setting the signature to 4/4 means that 
there 4 quarter notes in a bar, if signature is 3/4 (waltz) it means there are 3 quarter 
notes in a bar. 

2. Click to change the lower part of the time signature of the current pattern. This 
defines the note value (unit): 1=whole - 2=half note - 4=quarter note - 8=eighth note. 

3. Click to change the Step resolution. The step resolution is the value of one step: 
1/16=sixteenth note - 1/8=eighth note - 1/4=a quarter note, etc. A pattern has from 1 
to a maximum of 64 steps. 

4. Click to change the number of bars in the current pattern. 

5. Click to change the total number of steps in the current pattern. The number of 
steps is automatically calculated by Spark using the step resolution, the number of bars 
in the pattern, and the time signature. But you can adjust it if you want to work with 
your own bar calculation. 

6. Click to display Step 1 to 16 in the current pattern. 

5.4.4 The Sequencer 
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The Pattern panel shows 8 instrument tracks out of the 16 available. To see the next 8 
tracks, use the scroll bar. 

The picture above shows the pattern panel with a time signature of 4/4, hence 1 bar of 4 
quarter notes (each quarter note subdivided into 4 1/16 note steps)- which adds up to 
16 1/16 note steps. 

1 Click to display the Pattern panel 

2 Click to display the Song panel 

3 Click to display the preferences panel 

4 Set Step on/off on one track in the current pattern 

5 Select a track in the current pattern. (Hover above the track until it 
lights up, then click).  

6 Set Solo on/off on one sequencer track in the current pattern. (The 
solo button in the center panel will flash to indicate that a solo has 
been set from another panel (studio, mixer or sequencer)). 

7 Set Mute on/off on one sequencer track in the current pattern. (The 
Mute button in the center panel will flash to indicate that a mute has 
been set from another panel (studio, mixer or sequencer)). 

8 Click to open or close the Automation editor for one track in the 
current pattern. 

5.4.4.1 How to select a track 

To select a track, move your cursor over the track. When the track lights up, click to 
select. 

5.4.4.2 How to copy or swap tracks 

To copy a track, move your cursor over the track. When the track lights up, click 
[Option/alt] on Mac / [Ctrl] on Windows, then click and drag the track onto another one.  

To swap tracks, just drag a track onto another one. 

5.4.4.3 How to copy or swap Step parts 

To copy step parts click on a step part button while holding [Option/Alt] on Mac / [Ctrl] 
on Windows and drag it onto another one. 

To swap step parts, click on a step part and drag it onto another one. 
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5.4.5 The Automation editor 

 

 

1 Click to display the automation value of a single parameter in the current 
pattern. 

2 Pen tool – Line tool – Eraser tool 

3 Click and drag to draw automation on a single parameter using the pen or 
line tool or erase drawing. Except for velocity, repeat and shift parameters, 
you can use up to 4 sub-values per single step. Use Cmd on mac and Ctrl on 
windows to erase or move the four automation sub-values of a single step 
note together 

4 Disable/Enable all automations in the current pattern. 

5 Disable/Enable one single automation in the current pattern. 

6 Click to trigger drop down menu of parameters on to which automations may 
be applied.  
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5.4.6 The Song Panel 

 

The song panel allows you to chain all your patterns to create a Song.  

As we have seen before, a song is an editable ordered sequence of several patterns that 
defines the structure of your song.  

SPARK allows songs made of 64 patterns maximum. 

The Song panel will allow you to organize your patterns in sequences to make your song. 

1 Click and drag a pattern from one bank into a song slot. 

2 Select song slot and click "copy" button [C] to copy into SPARK clipboard. 

3 Click on destination slot then click on paste [P]. If you have copied 3 slots, 
the 3 slots located at your paste location will be replaced. 

4 If bars are copied into clipboard, click on a slot where you want to insert 
selection and click [Insert] 

5 Once slots are selected you can click on [Delete] to delete them. This will 
shift back all the slots that were located after the last deleted bar. 

6 Song slots are numbered from 1 to 64. Click to select. 

5.4.7 The Song slots 

The Song plays chained patterns from the first one to the 64th.  

The song is organized in 64 slots; each slot can receive a pattern. But your song can be 
any number of patterns with a maximum of 64. 

5.4.7.1 How to copy patterns to song slots. 

To copy a pattern to a song slot, click on a pattern in the pattern wheel and drag it to a 
song slot.  
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5.4.7.2 How to move and paste/insert slots  

You can select a slot or a group of slots and paste or insert them in another location. 

To do so, once the slot (or group of slots) has been selected, drag the selection and drop 
it onto another slot: If your mouse pointer is on the first half of a bar this will insert the 
dragged  pattern at the location. If your mouse pointer is in the last half of a bar, it 
will be pasted and will replace bars at location 

5.4.7.3 How to set song playing position 

Double click on a slot to set the song playing position. 

5.4.7.4 How to select several slots 

To select several song slots, just click on a slot and drag your cursor over the 
neighboring slots. 

5.4.8 Preferences Button 

 

The preferences are divided into: 

• Sequencer 
• Interface 
• File 
• Jog dial 
• MIDI Import/Export 
• Controller 

5.4.8.1 Sequencer and interface preferences 

Switch pattern instantaneously: If set to "Yes", a new pattern will play instantaneously 
when it is selected. If set to "No", it will be played when the current pattern is finished 
playing.  

Follow current step: When set to "Yes", and when on Sequencer panel, the step pads on 
the center panel will automatically display the step part that contains the current played 
step. 
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Quantize record: When set to "Yes", all pads playing as well as any recordings will be 
quantized. 

Auto-start song: When on, clicking on the Song button in the center panel will open the 
song panel and start playing the song automatically. 

Click Output: Selects output for metronome click. 

Next Bank/Pattern switch mode: When set to immediately, clicking a different bank will 
directly play the same pattern number in the new bank. Otherwise, one must first select 
the new bank, then specify the pattern of this new bank, even if it's the same pattern 
number as the currently played pattern. 

Automation Loop free: When on, the loop will be applied only on notes in the pattern, 
not on automations. 

 Choose your skin: switch Spark backgrounds from default to vintage. 

 

5.4.8.2 File preferences 

Save a copy of Audio samples in Library: When importing .wav/.aiff files to Spark, the 
source file will be copied in the library. You have the choice between: 

• Always: always copy files in the library 
• Ask: ask the user 
• Never: never copy files in the library 

Library path: Changes the path to SPARK's library. 

5.4.8.3 MIDI Import/Export preferences: 

Pattern Drag&Drop export mode in library: When dragging a pattern in the library panel, 
the pattern will be exported as MIDI file or bounced to .wav file. 

Wave export size: When saving a pattern as a .wav file, you can choose between 
exporting the pattern in its initial size, or doubling the size of the pattern. Doubling the 
size will avoid losing an effect playing beyond the end of the pattern (i.e. a reverb or a 
delay).  

Choose Drum map model for MIDI pattern import: When importing a MIDI pattern, you 
have the choice to import it as a SPARK, General MIDI or ADDICTIVE Drum map.  

Choose MIDI map model for Pads: You can choose an existing mapping for the pads 
being controlled by an external midi controller. Spark Option is the mapping used by 
Spark controller, General Midi is a standard midi mapping, and you can define your own 
mapping using “Custom” Option and assigning midi notes on pads using Cmd-Click on 
OSX or Ctrl on Windows on pads.  

“Enable default Pad velocity” preference is used to trigger pads with a constant velocity 
defined with the “Default Pad Velocity” preference. Hit intensity is ignored when this 
preference is set to “Yes”. 

Use the Send Midi preferences to select which kind of midi data has to be sent from 
Spark to your host or from Spark to the selected Output Midi port: 

Choose “Send Midi From Pads” for sending midi data from Spark pads, and pattern 
changes to your host 

Choose “Send Midi From Sequencer ” for sending midi data coming from Spark’s 
sequencer to your host 
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5.4.8.4 Controller Preferences  

Knobs speed sets the reactivity of the knobs in Spark, and can vary between slow, 
normal and fast. 
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6  MODES OF OPERATIONS 

6.1  STANDALONE (OVERVIEW) 

6.1.1 Launching the standalone application 

To launch the standalone application: 

• On Windows: Start menu > Programs > Arturia > Spark… and choose 
Spark. 

• On Mac OS X: Finder > Applications > Arturia > Spark… and double-click 
on the Spark application icon. 

6.1.2 Preferences configuration – Audio & MIDI settings 

6.1.2.1 Windows 

To access the preferences window click on the SPARK menu > Setup > Audio & MIDI 
Settings. This window allows you to configure the global preferences of SPARK. These 
are saved automatically.  

 



ARTURIA – SPARK CREATIVE DRUM MACHINE – USER’S MANUAL 75 

6.1.2.2 Mac OS X 

To access the preferences window click on the SPARK menu > Preferences. The Audio 
settings window will appear. This window allows you to set the global preferences of 
SPARK. These are saved automatically.  

   

 

 

(Windows)  
AUDIO DEVICE TYPE 

Selects the appropriate driver for your audio device. 

(Mac_OS) OUTPUT 

(Windows) DEVICE 

Chooses which audio output SPARK will send sound out of. 
Default is “Built-in Output” on the Mac; for Windows we highly 
suggest to use an adequate ASIO driver for your sound card. 

TEST Send out a short sine wave tone to help make sure sound is 
being sent out the correct device.  

SAMPLE RATE Choose the sample rate; default is 44,100 Hz. Increasing the 
sample rate increases the quality of sound, but adds a bigger 
load to CPU. 

AUDIO BUFFER SIZE Chooses the audio buffer size, displayed in samples and 
milliseconds. Default is 512 samples. Decreasing this number 
lowers latency, but adds more load to CPU. Increasing lessens 
load on CPU but augments latency (latency is the delay between 
a note played and actual sound output).  

MIDI OUTPUT Displays the available MIDI outputs that can be used to send 
Midi data out from Spark Sequencer and Pads in Standalone 
Mode.  

ACTIVE MIDI 
INPUTS 

Displays the available MIDI inputs that can be used to control 
SPARK.  

MIDI CLOCK IN 
INPUTS 

Displays the available MIDI Inputs for receiving Midi Clock to 
control Spark Sequencer. When a port is used as a Midi clock 
receiver, it can’t be used as Midi Inputs for controlling Spark. 

CLOCK FOLLOWS 
STOP/CONTINUE 

Sequencer will start and stop playing according to the Start and 
stop Command received with the Midi clock signal when the 
preference is on.   
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6.1.3 Update Spark Controller  

 To access the Update Spark Controller Menu Item, click on SPARK menu > 
Update Spark Controller. 

When you update Spark Software, your controller firmware may need to be 
updated as well. Spark will warn you when starting with Spark controller 
connected. Use this command to update your controller when Spark warns you. 

6.2  PLUG-IN MODE 

For specific use in VST, Audio Unit and RTAS please refer to 6.3, 6.4 and 6.5 sections. 

 

In order for Spark controller to work correctly with Spark used in plug-in mode, it is 
necessary to turn off some MIDI connections in your sequencer software. Go to your 
sequencer's MIDI settings and turn off 'Spark Private In' and 'Spark Private Out'. Without 
this configuration:  

- Spark controller will not connect to Spark on Windows.  

- Spark controller will not behave correctly on OSX. 

 

You can use Spark as plugin in stereo or Multi Output Mode. The host will show one 
stereo output from Spark when used in Stereo Mode. When used in Multi output mode 
the host will show 16 stereo channels available. You can modify the track output routing 
in Spark in the mixer panel. Default routing sends all tracks to the master stereo output, 
the first output. You can assign a track output to another stereo output of the 16 
available outputs. See Chapter 5.3.2.1 

6.2.1 Toolbar Extra Buttons 

When using SPARK in Plug-in mode, the toolbar features 2 additional buttons: 

 

1.  Host button 

When on, the current Spark pattern will start and stop along with the Host 
sequencer transport. 

2.  Tempo button 

When on, the current Spark tempo will be set to the host tempo. 
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6.2.2 Saving project 

When the project is saved, SPARK is saved in its last mode of operation, with all 
modifications intact. For instance, if you are working on a project in which you have 
modified parameters (without saving this as a separate preset in the plug-in itself), the 
next time you open the project SPARK will load the project and the modifications as well. 

The drop-down menu with the VST sequencer, allowing you to save a new project, is of 
course usable with SPARK. However, it is highly advised to use the SPARK’s internal 
menu: the presets saved in this way are usable in any other mode (standalone or with 
another sequencer), and can be exported and exchanged more easily, as well as remain 
compatible with future SPARK versions. 

6.2.3 Recording Midi out From Spark Sequencer and Pads into your host 

Midi Out from Spark Software sequencer, from pads and from pattern changes can be 
recorded in a host. All notes coming out from the Spark’s patterns can be recorded, 
additionally to automations. This feature is working for the AU and VST Spark plugin and 
not yet available for RTAS. 

Use the preferences to select which kind of midi data has to be sent: 

Choose “Send Midi From Pads” for sending midi data from Spark pads, and pattern 
changes to your host 

Choose “Send Midi From Sequencer ” for sending midi data coming from Spark’s 
sequencer to your host. 

 

6.3  VST 

6.3.1 Installation 

6.3.1.1 Windows 

During installation, select the box “VST” among the proposed format choices of plug-ins. 
The installer will automatically detect the VST folder of the instruments shared by 
Cubase or any another compatible VST sequencer.  

6.3.1.2 Mac OS X 

The VST plug-in is automatically installed in the folder of the system corresponding to 
the VST instruments: /Library/Audio/Plug-Ins/VST/ 

The VST plug-in will be usable by all your VST host applications.  

6.3.2 Instrument use in VST mode 

The opening of VST SPARK plug-ins is the same as opening all other VST plug-ins. Please 
consult the instruction manual of your favorite host sequencer for more specific 
information.  

For instance, under Cubase, open the menu “VST Instruments”, and choose Spark in the 
rack. 
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6.3.3 Connection to an instrument track 

 

In order for SPARK to play information coming from an Instrument track, you have to 
choose an Instrument track and select Spark as the output of this track. See the picture 
below for more detail on how this is accomplished. 

 

The events played on a MIDI keyboard are recorded by your host sequencer, and you 
can now use the MIDI editing possibilities of the sequencer to control any parameter in 
SPARK. 

6.3.4 Multi Output Mode 

Create an instrument using the VST Instrument Menu then click on Spark; then select 
the output you want to enable by clicking on the button just on the left of the instrument 
name in this menu. 
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6.3.5 Recording Midi out from Spark into your VST host  

Here’s an example of a VST Host configuration for recording Midi out from Spark using 
LIVE. 

- Add Spark VST plugin on a Live track. 

- Add a Midi track for recording Midi from Spark 

- Configure the new Midi Track (left track on the image):  

. Set ‘Midi From’ to ‘Spark’ and change ‘Pre FX’ to ‘Spark’ in the following combo 

. Set Monitor to ‘Auto’ 

. Arm the session recording 

- Configure the Spark Track (right track on the image):  

. Set ‘Midi From’ to the new Midi Track (2 Midi in this example) 

. Set Monitor to ‘Auto’ 

 



ARTURIA – SPARK CREATIVE DRUM MACHINE – USER’S MANUAL 80 

Press Record button in Live.  Note that Host and Tempo button must be on in Spark 
software.  

Display the Arrangement view (press Tab) in Live and check that you’ve recorded some 
midi notes. 

 

 

Set Monitor to ‘in’ on the Spark track 

Set Spark Host button to off (Pressing Play button in Live will not start Spark sequencer 
anymore ) 

Press play in Live from the beginning of your arrangement. You should hear Spark 
playing notes previously recorded from Spark and now sent by Live. 

Note: For Cubase users:  use Menu > Devices > VST Instrument to load Spark in order 
to be able to select Spark as Midi source. Creating a vst instrument Track will not display 
Spark as Midi source. 

6.4  AUDIO UNIT (MAC OS X ONLY) 

6.4.1 Installation 

The Audio Unit plug-in is automatically installed and by default in the following folder: 
/Library/Audio/Plug-Ins/Components/ 

6.4.2 Use in Logic Pro 

From version 7 and on, Logic Pro features an Audio Unit plug-in manager. To launch the 
Audio Unit plug-in manager, click on the menu Preferences > Audio Units Manager.  

 

This Manager will show you the list of available plug-ins, test their compatibility with 
Logic, and then allow you to activate or de-activate them. 
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If an Arturia plug-in poses problem in Logic, start by checking that this plug-in has 
passed the compatibility test, and that it is actually selected. 

6.4.2.1 Stereo Mode 

Select an Instrument track. On the mixer portion of the corresponding track, click on the 
button “I/O” to obtain the list of plug-ins, then select AU Instruments > Arturia > Spark 
> Stereo. 

 

6.4.2.2 Multi Output Mode 

To use the separate outputs:  

Select an Instrument track. On the portion of the mixer corresponding to the selected 
track, click on the button “I/O” to obtain the list of plug-ins, then select AU Instruments 
> Arturia > Spark > Multi Output (16xStereo).  

 

Then go to the mixer view and click on the “+” button at the bottom of the instrument 
track to add Aux tracks. 
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You can choose the output number of each instrument in Spark in the Mixer View. (see 
chapter 5.3.2.1. 

6.4.3 Recording Midi out from Spark into your VST host 

For better precision, it’s not recommended to use the 2 options concurrently: First record 
midi from pads turning on the “Send Midi From Pads to Host” option and off the “Send 
Midi From Sequencer to Host”, then record midi from sequencer turning off the “Send 
Midi From Pads to Host” option and on the “Send Midi From Sequencer to Host”. 

- Launch ‘Audio Midi Setup Application’ to configure the IAC Driver that will be used for 
sending Midi data to the AU host. Double clic on the IAC Driver Icon in the Midi Studio 
view 

 

- Check ‘Device is online’ 

- Rename firt port to ‘Spark1 MIDI OUT’ 

 

- Launch Logic 

- Create an instrument track and Add Spark AU plugin 

- Set Host and Tempo button on into Spark Software 

- Open Window > Environment 
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- Select in the upper left combo ‘Click & Ports’ 

- In the Physical Input box , create a connection from Spark1 MIDI OUT’ to Sequencer 
Input 

 

- Select Spark Track 

- Set ‘Record’ OFF on the Spark track  

- Press record into Logic 

- Set Host button to off into Spark Software 

- Play your recorded pattern 

 

 

6.4.4 Use in Digital Performer 

6.4.4.1 Stereo Mode 

To add an instrument, choose the menu Project > Add Track > Instrument Track > 
Arturia > Spark (stereo) 

 

Once you have added this instrument, it’s possible to assign a MIDI track to it. In the 
connection menu of the MIDI track, select the instrument and the MIDI channel that you 
want to use. Make sure you activate the track before starting to play or record. 

6.4.4.2 Multi Ouput Mode 

To use the separate outputs, create the number of new Audio tracks you want, and then 
choose the correct OUT of the Spark plugin. 
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6.4.4.3 Assign Midi Track 

Once you have added this instrument, it’s possible to assign a MIDI track to it. In the 
connection menu of the MIDI track, select the instrument and the MIDI channel that you 
want to use. Make sure you activate the track before starting to play or record. 

6.4.5 Stereo Mode and Multi Output Mode 

6.4.5.1 Stereo Mode 

To add an instrument, choose the menu Project > Add Track > Instrument Track > 
Arturia > SPARK. 

Once you have added this instrument, it’s possible to assign a MIDI track to it. In the 
connection menu of the MIDI track, select the instrument and the MIDI channel that you 
want to use. Make sure you activate the track before starting to play or record. 

6.4.5.2 Multi Output Mode 

To use separate outputs: select an Instrument track. Then on the portion of the mixer 
corresponding to the selected track, click on the button “I/O” to obtain the list of plug-
ins, then select AU Instruments > Arturia > SPARK > Multi Output (16xStereo).  

6.5  PRO TOOLS 

6.5.1 Installation 

In Mac OS X, the plug-in is directly installed in the folder reserved for the ProTools plug-
ins in: 

/Library/Application Support/Digidesign/Plug-Ins 

In Windows, at the time of the installation procedure, select the RTAS plug-in among the 
proposed choices of plug-ins. Then, when the system asks, indicate the folder in which 
the other RTAS plug-ins are located.  

Usually, this path is:  

C:\Program Files\CommonFiles\Digidesign\DAE\Plug-Ins\ 



ARTURIA – SPARK CREATIVE DRUM MACHINE – USER’S MANUAL 85 

6.5.2 Utilization and opening of the Plug-in 

Access to the SPARK plug-in is like all other plug-ins; simply create a stereo Instrument 
track:  

 

In order for SPARK to play the information coming from the Instrument track, you have 
to associate it to an Insert channel via the appropriate menu.  

More information on plug-in connections can be found in the Pro Tools User’s Manual. 

6.5.3 Saving the project 

When the session is saved, the status of SPARK is saved as it is, even if its programming 
does not correspond to the preset. For example, you are working on a project in which 
you have modified the parameters (without saving them in the plug-in itself), the next 
time you open the session SPARK will load the project plus the modifications. 

The Librarian Menu of Pro Tools can be used with SPARK as with any other plug-in. 
Nevertheless, it is highly recommended to use the internal SPARK menu: with the 
presets saved this way, they are usable no matter which mode is used (standalone or 
other sequencer), and they can be exported and exchanged more easily. They will stay 
compatible with the future versions of SPARK. 

6.5.4 Automations under Pro Tools 

The automation in SPARK works as with all RTAS/HTDM plug-ins. 

Please refer to the Pro Tools documentation for more details on automation plug-ins. 
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7  THE SPARK MIDI CONTROLLER  

7.1  FRONT PANEL (OVERVIEW)  

The SPARK's Hardware Controller has the same interface as the Main Panel  in the 
SPARK software version. In this overview, we will focus on the features specific to the 
Hardware controller. 

 

 

 

 

 

 

 

 

 

 

 

1. Digital Display 

2. Sequencer zone 

3. Song/Pattern zone 

4. Jog dial 

5. FX live Pad 

6. Instrument control zone 
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7.1.1 Device ports  

The Spark controller is listed by a host as being made up of 2 MIDI ports:  

The first one:  

- On Windows Vista and 7: "MIDIIN2(Spark Controller)"  

- On Windows XP: "Spark Controller [2]"  

- On Mac: “Spark Private IN” and “Spark Private OUT” 

is used for internal communication between SPARK and the Controller. This MIDI port 
SHOULD NEVER BE USED by the user; doing so would impair the efficiency of the 
controller.  

The second one:  

- On Windows Vista, 7 and XP: "Spark Controller"  

- On Mac: “Spark Public IN” and “Spark Public OUT” 

is the public port to be used by the user.All messages sent to this port will be sent out 
the controller's MIDI OUT. All messages sent to the MIDI IN port by a third party 
machine will be transmitted to the host on the public port. When using Spark's Hardware 
as a MIDI controller, the data flow from the controller will be sent on the USB public port 
to the host, as well as on the MIDI  OUT port, adding itself to any other existing MIDI 
information.  

7.1.2 Choose between Kit or Instrument mode  

To change from Kit/Project (depending on the option you’ve selected in the Preferences 
Panel of the Spark software) to Instrument mode on SPARK's Hardware controller, press 
and hold for 1 second the Jog Dial to change from Kit to Instrument mode.  

7.1.3 Set Move Knob Mode  

Move Knob is a clickable knob used to switch from “Shift by one step” mode to “Shift by 
one loop size mode”. 

7.1.4 Set Sequencer Follow Mode On / Off  

To set Sequencer Follow mode on or off, press << and >> buttons together.  

7.1.5 Roller Fx  

When using the Roller effect in the software version of SPARK, the Roll effect can be 
applied only to one instrument at a time, for the obvious reason that you are using your 
mouse to play the instrument.  

When using the Hardware controller, you are free to apply the Roll effect to any number 
of instruments, simultaneously. You can also start a roll on one instrument and press 
another instrument pad while maintaining your initial Roll. Enjoy! 
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The Roll velocity is triggered on the software version by clicking on a pad and while 
maintaining your click, moving the cursor up and down on the pad. This can be done on 
the Hardware controller thanks to its Sensitive pads sending Aftertouch information: the 
instrument pad being “pressure sensitive" you can modulate the velocity applied to the 
Roll effect in real time.  

7.1.6 Controller Shortcuts   

 

 

7.1.7 Overlay cheat sheet mode Software interface  

A help mode is available for displaying all controller shortcuts. Click on the  
in the upper left corner in order to switch Spark interface to show all the 
shortcuts the names of the instruments that are loaded and to display all the 
Filter and Slicer modes. Any text that is in Blue above a button shows that by 
pressing and holding SELECT+ the button, you will select this secondary 
function. 
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7.1.8 Use as Spark Controller  

To use your SPARK hardware controller as a SPARK controller, launch Spark Software 
(then press the Connect button on SPARK's toolbar if needed).  

 

If you were in MIDI Controller mode Press the [Filter]+[Slicer]+[Roller] buttons. 

7.1.9 Use as MIDI Controller  

To use your SPARK Controller as MIDI controller, Press [Filter] + [Slicer] +[Roller] (then 
open public MIDI port or connect a MIDI cable to MIDI Out). 

7.1.10  Use as USB/MIDI interface  

To use your SPARK Controller as USB/MIDI interface, open the public MIDI port in your 
host program and connect the MIDI cable(s) to your Spark Hardware controller. 
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7.1.11  Power Supply  

Connect to USB 2.0 host. Avoid using a non-powered USB-Hub. The device is self-
powered by USB. 

If you don't need or want to power your Spark Hardware controller via USB, use the DC 
jack input with the following power supply unit:  

Voltage: 9 Vdc 

Current: 800 mA 

Polarity: center positive 

7.2  REAR PANEL (OVERVIEW)  

7.2.1 Rear panel Connectors and power supply  

 

1. USB connector 

2. MIDI IN port 

3. MIDI OUT port 

4. Power supply 

5. Power on/off switch 

 

 

 

7.3  SPARK MIDI CONTROLLER SOFTWARE  

With the SPARK MIDI controller software you can customize the functions of the Pads, 
Knobs and Buttons according to your needs.  
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When connected, you can use the Hardware controller itself instead of the Controller 
software interface to select the buttons, switches or knobs you want to work on. 

Spark Midi Controller Software needs Spark Controller to be in Midi Controller mode to 
be able to connect to. Press [Filter] + [Slicer] +[Roller] to use Spark as Midi Controller. 
If Spark Controller is set to Midi Controller mode before opening Spark Midi Controller 
Software, Spark Midi Controller Software will connect to it automatically at launch. If 
Spark Midi Controller Software is started before setting Spark Controller to Midi 
Controller Mode, you will need to explicitly connect to Spark controller using Connect to 
Spark Controller command in the Action Menu. 

 

7.3.1 Overview  

 

The SPARK MIDI controller software interface is rigorously the same as the SPARK 
Hardware interface or SPARK software main panel. 

All the buttons, pads and knobs can be reprogrammed to suit your needs. 
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7.3.2 The Menu  

 

 

1. File > Open…: Open and Load a Template 

2. File > Save: Save A Template on the Computer 

3. File > Save As…: Save As A Template on the Computer 

4. Action > Connect to Spark Controller: Disconnect Or Connect 
to Spark Controller 

5. Action > Send To Spark Controller: Send Template to Spark 
Controller 

6. Action > Update Spark Controller: Update Spark Controller 
Firmware 

7. Action > Calibrate Pads: Calibrate the velocity sensitivity of 
the Pads 

8. Action > Restore Factory Calib: Restore Factory Calibration of 
the Pads 

7.3.2.1 Midi Templates 

 

Midi Templates: Each control (Pad, Knob or Button) sends a Midi message to the USB 
output. Default midi mapping is used for controlling Spark Software. You can customize 
this mapping, editing Midi messages sent from any of the controls. New mappings can be 
saved as Template Files using the File > Save command. In order for a template to be 
active on Spark controller you need to send your template to Spark controller with 
'Action > Send to Spark Controller' command. Only one template can be active on Spark 
controller at a time. 
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7.3.2.2 Pads Calibration 

You can calibrate the hit intensity at which the maximum velocity will be reached on the 
Pads of your Spark controller. Use 'Action>Calibrate Pads' command to start the 
calibration process. You will be asked to hit each pad 3 times. 

 

Led indicators show you the progress of the calibration: 

 

You can restore the Factory calibration using Action>Restore Factory Calib" command. 

7.3.3  

7.3.3  

7.3.3  

7.3.3  

7.3.3  

7.3.3  

7.3.3  

7.3.3  

7.3.3  

7.3.3  

7.3.3  

7.3.3 Edit Instrument Pad window  

When clicking on a pad, a window appears with several tabs and drop-down  menus to 
let you change the parameters assigned to pads. 

 

1. Edit Pads Trig MIDI Message 

2. Edit Pads Press MIDI Message 

3. Edit Pads Mute MIDI Message 

4. Edit Pads Solo MIDI Message 

5. Edit Pads Select MIDI Message 

6. Choose Switch (and Pad) MIDI Message Type 

(Choice between CC, Note, Start, Stop, Continue, Program Change, 
Channel Pressure, Aftertouch and Off). 

7. Choose Switch MIDI Message Number 

(Not available for Start, Stop, Continue) 
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8. Choose Switch MIDI Message Channel 

(Not available for Start, Stop, Continue) 

9. Choose Switch MIDI Message Mode. Choice between Gate and Toggle.  

(Not available for Start, Stop, Continue) 

10. Choose Switch MIDI Message Minimum Value 

(Not available for Start, Stop, Continue) 

11. Choose Switch MIDI Message Maximum Value 

(Not available for Start, Stop, Continue) 

12. Choose Switch MIDI Message Action On. Choice between Push or Release 
(Not available in Gate Mode) 

7.3.4 Edit Instrument knob window  

 

1. Edit Instrument 1 to 8 Knob MIDI Message 

2. Choose Knob MIDI Message Type 

(Choice between CC and Off) 

3. Choose Knob MIDI Message Number 

(0 to 127) 

4. Choose Knob MIDI Message Channel 

(1 to 16) 

5. Choose Knob MIDI Message Mode 

(Choice between Absolute, Relative1, Relative2, Relative3) 

6. Choose Knob MIDI Message Min Value 

(0 to 127 (should be < max val)) 

7. Choose Knob MIDI Message Max Value 

(0 to 127 (should be > min val)) 

8. Choose Knob MIDI Message Acceleration 

(Choice between None, Slow and Fast - not available for encoder 
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with detent: Encoders with detent are Move, Jog Dial, Loop) 

7.3.5 Edit Instrument parameter knob window  

 

1. Edit Instrument parameter knob 1 to 8 MIDI Message 

2. Choose Knob MIDI Message Type 

(Choice between CC and Off) 

3. Choose Knob MIDI Message Number 

(0 to 127) 

4. Choose Knob MIDI Message Channel 

(1 to 16) 

5. Choose Knob MIDI Message Mode 

(Choice between Absolute, Relative1, Relative2, Relative3) 

6. Choose Knob MIDI Message Min Value. 0 - 127 

(should be < max value) 

7. Choose Knob MIDI Message Max Value. 0 - 127 

(should be > min value) 

8. Choose Knob MIDI Message Acceleration 

(Choice between None, Slow and Fast - not available for encoder 
with detent: Encoders with detent are Move, Jog Dial, Loop) 

7.3.6 Edit Clickable knob window  

You will find only 2 clickable buttons on SPARK's Hardware: 

7.3.6.1 The Jog Dial (Wheel) 

 

1. Choose MIDI Message Type 
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(Choice between CC, Note, Start, Stop, Continue, Program Change, 
Channel Pressure, Aftertouch and Off). 

2. Choose Action on MIDI Message  

(Choice between Push/release) 

7.3.6.2  The Move button (Loop Move) 

1. Choose MIDI Message Type 

(Choice between CC, Note, Start, Stop, Continue, Program Change, 
Channel Pressure, Aftertouch and Off). 

2. Choose Switch MIDI Message Number 

(0 to 127) 

3. Choose Switch MIDI Message Channel 

(1 to 16) 

4. Choose Switch MIDI Message Mode.  

(Choice between Toggle, Trigger, Gate, Inc, Gate and Toggle).  

5. Choose Knob MIDI Message Min Value. 0-127 

(should be < max value) 

6. Choose Knob MIDI Message Max Value. 0-127 

(should be > min value) 

7. Choose Switch MIDI Message Action On. Choice between Push or Release 
(Not available in Gate Mode) 

8. Choose Action on. 

(Choice between Push/Release) 

7.3.7 Edit Touch pad window  

 

1. Choose Touch Pad MIDI Message Type 

(Choice between CC and Off) 

2. Choose Touch Pad MIDI Message Number 
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(0 to 127) 

3. Choose Touch Pad MIDI Message Channel 

4. Choose Touch Pad MIDI Message X or Y Minimum Value 

0 to 127 (should be < maximum value)  

5. Choose Touch Pad MIDI Message X or Y Maximum Value 

0 to 127 (should be > minimum value) 

7.4  CONTROLLING SPARK AN EXTERNAL MIDI CONTROLLER  

7.4.1 Assign a MIDI note to pads 

Click holding [Cmd] on Mac / [Ctrl] on Windows on [Pads] #115 to #122 and press 
button or key on your MIDI controller. 

7.4.2 Assign a MIDI note to bank buttons 

Same as previous on corresponding button/pad. 

7.4.3 Assign a MIDI note to pattern buttons 

Same as previous on corresponding button/pad. 

7.4.4 Assign a MIDI note to loop on button 

Same as previous on corresponding button/pad. 

7.4.5 Assign a MIDI CC to Loop divide knob 

Click holding [Cmd] on Mac / [Ctrl] Win on [Loop] #49 and move knob or fader on your 
MIDI controller. 

7.4.6 Assign a MIDI CC to Loop Move knob 

Same as previous on corresponding knob. 

7.4.7 Assign a MIDI CC to shuffle knob 

Same as previous on corresponding knob. 

7.4.8 Assign a MIDI CC to master Volume knob 

Same as previous on corresponding knob. 
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7.4.9 Assign a MIDI CC to cutoff/res/Pan/Aux1/Aux2/Volume knobs 

Same as previous on corresponding knob. 

7.4.10 Assign a MIDI CC to instrument parameters knobs 

Same as previous on corresponding knob. 

7.4.11 Assign a MIDI CC to tempo knob 

Same as previous on corresponding knob. 
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8  SPARK CREATIVE DRUM MACHINE LEGAL 
INFORMATION 

8.1  SOFTWARE LICENSE AGREEMENT 

In consideration of payment of the Licensee fee, which is a portion of the price you paid, 
Arturia, as Licensor, grants to you (hereinafter termed “Licensee”) a nonexclusive right 
to use this copy of the Spark Creative Drum Software (hereinafter the “SOFTWARE”). 

All intellectual property rights in the software belong to Arturia SA (hereinafter: 
“Arturia”). Arturia permits you only to copy, download, install and use the software in 
accordance with the terms and conditions of this Agreement.  

The product contains product activation for protection against unlawful copying. The OEM 
software can be used only following registration. 

Internet access is required for the activation process. The terms and conditions for use 
of the software by you, the end-user, appear below. By installing the software on your 
computer you agree to these terms and conditions. Please read the following text 
carefully in its entirety. If you do not approve these terms and conditions, you must not 
install this software. In this event give the product back to where you have purchased it 
(including all written material, the complete undamaged packing as well as the enclosed 
hardware) immediately but at the latest within 30 days in return for a refund of the 
purchase price. 

 

1. Software Ownership 

Arturia shall retain full and complete title to the SOFTWARE recorded on the enclosed 
disks and all subsequent copies of the SOFTWARE, regardless of the media or form on or 
in which the original disks or copies may exist. The License is not a sale of the original 
SOFTWARE. 

 

2. Grant of License 

Arturia grants you a non-exclusive license for the use of the software according to the 
terms and conditions of this Agreement. You may not lease, loan or sub-license the 
software. 

The use of the software within a network is illegal where there is the possibility of a 
contemporaneous multiple use of the program. 

You are entitled to prepare a backup copy of the software which will not be used for 
purposes other than storage purposes. 

You shall have no further right or interest to use the software other than the limited 
rights as specified in this Agreement. Arturia reserves all rights not expressly granted.  

 

3. Activation of the Software 

Arturia may use a compulsory activation of the software and a compulsory registration of 
the OEM software for license control to protect the software against unlawful copying. If 
you do not accept the terms and conditions of this Agreement, the software will not 
work. 

In such a case the product including the software may only be returned within 30 days 
following acquisition of the product. Upon return a claim according to § 11 shall not 
apply. 
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4. Support, Upgrades and Updates after Product Registration 

You can only receive support, upgrades and updates following the personal product 
registration. Support is provided only for the current version and for the previous version 
during one year after publication of the new version. Arturia can modify and partly or 
completely adjust the nature of the support (hotline, forum on the website etc.), 
upgrades and updates at any time. 

The product registration is possible during the activation process or at any time later 
through the Internet. In such a process you are asked to agree to the storage and use of 
your personal data (name, address, contact, email-address, and license data) for the 
purposes specified above. Arturia may also forward these data to engaged third parties, 
in particular distributors, for support purposes and for the verification of the upgrade or 
update right. 

 

5. No Unbundling 

The software usually contains a variety of different files which in its configuration ensure 
the complete functionality of the software. The software may be used as one product 
only. It is not required that you use or install all components of the software. You must 
not arrange components of the software in a new way and develop a modified version of 
the software or a new product as a result. The configuration of the software may not be 
modified for the purpose of distribution, assignment or resale. 

 

6. Assignment of Rights 

You may assign all your rights to use the software to another person subject to the 
conditions that (a) you assign to this other person (i) this Agreement and (ii) the 
software or hardware provided with the software, packed or preinstalled thereon, 
including all copies, upgrades, updates, backup copies and previous versions, which 
granted a right to an update or upgrade on this software, (b) you do not retain 
upgrades, updates, backup copies und previous versions of this software and (c) the 
recipient accepts the terms and conditions of this Agreement as well as other regulations 
pursuant to which you acquired a valid software license. 

A return of the product due to a failure to accept the terms and conditions of this 
Agreement, e.g. the product activation, shall not be possible following the assignment of 
rights. 

 

7. Upgrades and Updates 

You must have a valid license for the previous or more inferior version of the software in 
order to be allowed to use an upgrade or update for the software. Upon transferring this 
previous or more inferior version of the software to third parties the right to use the 
upgrade or update of the software shall expire. 

The acquisition of an upgrade or update does not in itself confer any right to use the 
software. 

The right of support for the previous or inferior version of the software expires upon the 
installation of an upgrade or update. 

 

8. Limited Warranty 

Arturia warrants that the disks on which the software is furnished is free from defects in 
materials and workmanship under normal use for a period of thirty (30) days from the 
date of purchase. Your receipt shall be evidence of the date of purchase. Any implied 
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warranties on the software are limited to thirty (30) days from the date of purchase. 
Some states do not allow limitations on duration of an implied warranty, so the above 
limitation may not apply to you. All programs and accompanying materials are provided 
“as is” without warranty of any kind. The complete risk as to the quality and 
performance of the programs is with you. Should the program prove defective, you 
assume the entire cost of all necessary servicing, repair or correction. 

 

9. Remedies 

Arturia's entire liability and your exclusive remedy shall be at Arturia's option either (a) 
return of the purchase price or (b) replacement of the disk that does not meet the 
Limited Warranty and which is returned to Arturia with a copy of your receipt. This 
limited Warranty is void if failure of the software has resulted from accident, abuse, 
modification, or misapplication. Any replacement software will be warranted for the 
remainder of the original warranty period or thirty (30) days, whichever is longer. 

 

10. No other Warranties 

The above warranties are in lieu of all other warranties, expressed or implied, including 
but not limited to, the implied warranties of merchantability and fitness for a particular 
purpose. No oral or written information or advice given by Arturia, its dealers, 
distributors, agents or employees shall create a warranty or in any way increase the 
scope of this limited warranty. 

 

11. No Liability for Consequential Damages 

Neither Arturia nor anyone else involved in the creation, production, or delivery of this 
product shall be liable for any direct, indirect, consequential, or incidental damages 
arising out of the use of, or inability to use this product (including without limitation, 
damages for loss of business profits, business interruption, loss of business information 
and the like) even if Arturia was previously advised of the possibility of such damages. 
Some states do not allow limitations on the length of an implied warranty or the 
exclusion or limitation of incidental or consequential damages, so the above limitation or 
exclusions may not apply to you. This warranty gives you specific legal rights, and you 
may also have other rights which vary from state to state. 

8.2  FCC INFORMATION (USA) 

Important notice: DO NOT MODIFY THE UNIT! 

This product, when installed as indicated in the instructions contained in this manual, 
meets FCC requirement. Modifications not expressly approved by Arturia may void your 
authority, granted by the FCC, to use the product. 

IMPORTANT: When connecting this product to accessories and/or another product, use 
only high quality shielded cables. Cable (s) supplied with this product MUST be used. 
Follow all installation instructions. Failure to follow instructions could void your FFC 
authorization to use this product in the USA. 

NOTE: This product has been tested and found to comply with the limit for a Class B 
Digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide 
a reasonable protection against harmful interference in a residential environment. This 
equipment generate, use and radiate radio frequency energy and, if not installed and 
used according to the instructions found in the user’s manual, may cause interferences 
harmful to the operation to other electronic devices. Compliance with FCC regulations 
does not guarantee that interferences will not occur in all the installations. If this product 
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is found to be the source of interferences, which can be determined by turning the unit 
“OFF” and “ON”, please try to eliminate the problem by using one of the following 
measures: 

• Relocate either this product or the device that is affected by the 
interference. 

• Use power outlets that are on different branch (circuit breaker or fuse) 
circuits or install AC line filter(s). 

• In the case of radio or TV interferences, relocate/ reorient the antenna. If 
the antenna lead-in is 300 ohm ribbon lead, change the lead-in to coaxial 
cable. 

• If these corrective measures do not bring any satisfied results, please the 
local retailer authorized to distribute this type of product. If you cannot 
locate the appropriate retailer, please contact Arturia. 

The above statements apply ONLY to those products distributed in the USA.  

8.3  CANADA 

NOTICE: This class B digital apparatus meets all the of the Canadian Interference-
Causing Equipment Regulation. 

AVIS: Cet appareil numérique de la classe B respecte toutes les exigences du Règlement 
sur le matériel brouilleur du Canada. 

8.4  EUROPE 

 This product complies with the requirements of European Directive89/336/EEC. 

This product may not work correctly by the influence of electro-static discharge; if it 
happens, simply restart the product. 
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9  NOTES:  


